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I 1 General Information

Read through this operating manual carefully before use and become familiar with the product.
Installation and start-up should not be carried out before reading and understanding this
document. Keep this manual readily available so that you can reference it as needed.

1.1 What Is the Purpose of this Operating Manual?

This manual serves as an aid for the installation and operation of the product and supports the
technical staff with all operating and maintenance tasks to be performed. Furthermore, this
manual is aimed at preventing dangers to life and health of the user and third parties.

1.2 Who Is this Operating Manual Targeted to?

The operating manual provides a code of conduct for personnel tasked with the setup,
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with
respect to the operation of gas engines and basic knowledge of electronic ignition systems are
necessary. Persons who are only authorized to operate the gas engine shall be trained by the
operating company and shall be expressly instructed concerning potential hazards.

1.3 Which Symbols Are Used in the Operating Manual?

The following symbols are used in this manual and must be observed:

Example

This symbol indicates examples, which point out necessary handling steps
and techniques. In addition, you receive additional information from the
examples, which will increase your knowledge.

EXAMPLE

Notice

This symbol indicates important notices for the user. Follow these. In
addition, this symbol is used for overviews that give you a summary of the
necessary work steps.

Warning

This symbol indicates warnings for possible risks of property damage or
risks to health. Read these warning notices carefully and take the
mentioned precautionary measures.

8 Rev. 01/2022



I 1 General Information

DANGER

Danger

£ MOTORTECH

This symbol indicates warnings for danger to life, especially due to high
voltage. Read these warning notices carefully and take the mentioned

precautionary measures.

1.4 Which Abbreviations/Acronyms Are Used in the Operating Manual?
In the manual or the user interface, the following abbreviations / acronyms are used.

Abb.
ADV

ASO

ATDC

BTDC

CAN bus

CE

CPU

°crankshaft

CSA

Rev. 01/2022

Term Description

Advance Advanced with
respect to top dead
center

Auxiliary

Synchronization

Output

After Top Dead

Center

Before Top Dead
Center

Bus for control
devices/networks

Controller Area
Network bus

Conformité
Européenne

Conformity with EU
directives

Central Processing
Unit

Degree crankshaft

Canadian Standards
Association

Explanation

Indicates the direction for
timing

Output for synchronizing the
MICs and other controllers

Asynchronous serial
connection system for
linking control units

Mark based on EU
legislation for certain
products in conjunction with
product safety

Unit for the rotation angle of
the crankshaft

Organization that defines
standards, inspects
products for safety
compliance, and issues
pertinent certifications.
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Abb. Term Description Explanation
DC Direct Current
DetCon Detonation Control Serves to prevent major
System engine damage that can be
caused by knocking
combustion.
EMI Electromagnetic
Interference
EMC Electromagnetic Compatibility of electrical or
Compatibility electronic equipment items
with their surroundings
GPI General Purpose Multi-purpose input
Input
GPO General Purpose Multi-purpose
Output output
HV High Voltage
1SO International

Organization for
Standardization

LED Light Emitting Diode Light emitting electronic
semiconductor
MIC MOTORTECH Ignition
Controller
MICT MOTORTECH Software for the
Integrated configuration of the MICs

Configuration Tool

MOSFET Metal Oxide Semiconductor component
Semiconductor Field-
Effect Transistor

PG Panzergewinde Panzer screw thread Screw thread type for cable
screw connections

POT Potentiometer Continuously adjustable
potential divider

PWR Power Output/current

RET Retard Retarded with Indicates the direction for

respect to the top timing
dead center
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Abb. Term
RS485/ Recommended
TIA485 Standard 485/

Telecommunications
Industry Association

485
TDC Top Dead Center
usB Universal Serial Bus

Rev. 01/2022
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Explanation

Industrial standard for a
physical interface for
asynchronous serial data
transfer

Serial connection system to
link a computer to external
devices
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I 2 Safety Instructions

2.1 General Safety Instructions
The following safety instructions must be followed in the area in which the device is operated:

High voltage! Danger to life!

While the engine is running, there is danger to life through high voltage
particularly in the area of the ignition system. The following parts should
therefore not be touched or removed unless explicitly stated otherwise:

DANGER

— Ignition coils and caps
— Wires of the high voltage circuit
— In- and output wiring of the ignition controller

— Pickups and their wiring

Danger to persons with pacemakers!

Electromagnetic impulses in the wiring of the ignition system may exceed
the permissible limits of pacemakers. Persons with pacemakers must
therefore not be present in the vicinity of the ignition system being
operated. Mark the operating location of the ignition system with the
corresponding standardized warning symbol.

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to
operate. Nevertheless the equipment can cause risks or damage can occur, if the following
instructions are not complied with:

- The gas engine must only be operated by trained and authorized personnel.

— Observe all safety instructions of the system and all safety instructions of the system
operator.

— Operate the equipment only within the parameters specified in the technical data.
— Use the equipment correctly and for its intended use only.
— Never apply force.

— Forall work such as installation, conversion, adaptation, maintenance, and repair, all
equipment must be disconnected from the mains and secured against unintentional
reactivation.

- Perform only such maintenance and repair work as is described in this operating manual,
and follow the instructions given while working.

- Only use spare parts supplied by MOTORTECH for the maintenance of the device.

—  Further work must only be performed by personnel authorized by MOTORTECH. Non-
compliance with the instructions will void any warranties for the proper function of the
equipment as well as the responsibility for the validity of the certifications.

12 Rev. 01/2022
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Safety devices must not be dismounted or disabled.

Avoid all activities that can impair the function of the equipment.

Operate the equipment only while it is in proper condition.

Investigate all changes detected while operating the gas engine or ignition system.

Ensure compliance with all laws, directives, and regulations applicable to the operation of
your system, including such not expressly stated herein.

If the system is not entirely tight and sealed, gas may escape and result in explosion hazard.
The inhalation of gas can also lead to death or severe health damages. Therefore, upon
completion of all assembly works, always check the system's tightness.

Always ensure adequate ventilation of the engine compartment.
Ensure a safe position at the gas engine.

There is a risk of burning on hot surfaces. Allow the gas engine to cool down before starting
any work.

Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all
work on the gas engine.

Noise from the system can cause permanent or temporary damage to your hearing. Wear
suitable hearing protection at the system.

Your behavior can reduce possible residual risks to a minimum. Observe responsible
handling of the gas engine and the gas-carrying system.

2.2 Electrostatic Discharge Hazards

Electronic equipment is sensitive to static electricity. To protect these components from damage
caused by static electricity, special precautions must be taken to minimize or prevent
electrostatic discharge.

Observe these safety precautions while you work with the equipment or in its vicinity.

Before performing maintenance or repair work, ensure that the static electricity inherent to
your body is discharged.

Do not wear clothing made from synthetic materials to prevent static electricity from
building up. Your clothing should therefore be made of cotton or cotton mix materials.

Keep plastics such as vinyl and Styrofoam materials as far away from the equipment as
possible.

Do not remove the circuit boards from the housing of the device.

Rev. 01/2022 13



I 2 Safety Instructions

2.3 Information on Electric Isolation
If ground and earth potential are not properly isolated, the following problems as well as others
can occur:

- Electromagnetic interferences (e.g. ground loops)

- Signal corruption (e.g. of the analog voltage signal)

— Unwanted leakage currents

Therefore, earth potential and the negative pole of the power supply of all devices in the electric
assembly that provide the option, should be connected separately. If possible, the negative pole

of the power supply should only be connected to earth potential at one point in the entire
system.

Wiring Example

Device with Device featuring
shielded wires protection class Il
o

ny
o

=

L+

24V DC
L-

a—
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® Occurrence of ground loops
The devices shown in the following image do not feature the possibility to
connect the earth potential and the negative pole of the power supply

oI separated from each other. How ground loops are created.

A ground loop is a ground connection of an electric wiring assembly that is
closed as a loop. Due to impedance (resistance R » 0) of the loop, low-
frequency interference currents can lead to an unwanted voltage drop in the

signal path.
Device 1 Device 2
II R II
|

—
||_

Ground loop

Rev. 01/2022 15



I 2 Safety Instructions

2.4 Special Safety Instructions for the Device

Explosion hazard!

If the system is located in a hazardous area, never open the device (e.g. by
opening the service screw or removing covers). There is a risk of explosion.

Explosion hazard!

The replacement of parts or assemblies can impair compliance with CSA
Class I, Division 2 (Group C, D), T4.

Explosion hazard!

Do not disconnect any connectors while the system is live. If the system is
located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Never remove the equipment while the unit is connected to a power source.
If the system is located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Do not remove or replace the fuse while the equipment is live.

Risk of burning!

The surfaces of the system may heat up to high temperatures.

Rev. 01/2022



1 2 Safety Instructions =MOTORTECH

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 20.

After the service cover on the device has been opened, e.g. to complete the
wiring, it must be refitted so that it is in the same alignment as it was prior
to opening. The USB connection must always be below the service screw. If
the mounting is rotated, maintaining the indicated protection classes, as
well as compliance with CSA-Class I, Division 2 (Group C, D) is impaired.

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating
manual.

Risk of destruction!

Magnetic fields and heat occur when welding, which may damage or
destroy the MICs. Therefore, pay attention to the following when welding:
— Disconnect all electrical connections to the MICs prior to welding.

— Protect the MIC5 against direct contact with the welding unit and
magnetic fields, sparks and liquid metal.

2.5 Proper Disposal

After the expiration of its service life, MOTORTECH equipment can be disposed of with other
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally
friendly disposal.

Rev. 01/2022 17



I 3Intended Use

3.1 Functional Description
The devices of the MICs series are microprocessor controlled ignition systems, that are
comprised of one 32 bit main processor (CPU) and an output board.

Please note that the manufacturer is not required to implement configurations of the ignition
controller for specific engines, and that devices may be delivered without pertinent
configuration.

The ignition controllers of the MICs series use information supplied by the pickups to precisely
determine the correct timing for the respective outputs. The timing is influenced by various
inputs made either automatically or manually. This can be implemented with manual
potentiometers, the analog input signals, a speed characteristic, or with a serial interface (USB,
CAN bus, RS485).

During operation, the ignition controllers continuously monitor the system status of all installed
pickups and the correct operation of the primary ignition circuit by checking the information
received.

Depending on the severity of an error that is detected, the device will shut down immediately or
warn the operator. A corresponding message can be viewed on a connected computer.

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off.

3.2 Applications

The ignition controllers of the MICs series are designed for specific 2- or 4-stroke gas engines.
From 1 to max. 20 ignition outputs are available. The ignition controllers supply the energy
required for the corresponding ignition coils of the gas engines and can supply signals for
peripheral equipment.

Any use other than the one described in the operating manual shall be considered improper use
and will result in the voiding of all warranties.
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4.1 Technical Data

4.1.1 Certifications
The ignition controllers of the MICs series are certified as per the following
directives/regulations:

CE
EMC Directive

- EN 61326-1 - Electrical equipment for measurement, control and laboratory use. EMC
requirements. General requirements

- EN 61000-6-2 — Electromagnetic compatibility (EMC). Generic standards. Immunity for
industrial environments

- EN 61000-6-4 — Electromagnetic compatibility (EMC). Generic standards. Emission standard
for industrial environments

- ENs55o11 - Industrial, scientific and medical equipment. Radio-frequency disturbance
characteristics. Limits and methods of measurement

- Groupi, Class A

Low Voltage Directive

- EN 61010-1 - Safety requirements for electrical equipment for measurement, control, and
laboratory use. General requirements

- EN 60529 — Protection classes by enclosure (IP code)

RoHS Directive

CSA
- (CSAStd C22.2 No. o -10

— (CSAStd C22.2 No. 142

- CSAStd C22.2 No. 213

- ANSI/ISA12.12.01

- UL Std No. 916

The EU Declaration of Conformity and the CSA Certificate of your MIC5 can be obtained on

request from your MOTORTECH contact person (see section Customer Service Information on
page 169).
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4.1.2 Mechanical Data
The MICs has the following mechanical characteristics.

Dimensions MICs:
max. 375.2 mm X 240 mm X 115.2 mm (max. 14.77" X 9.45" X
4.54") (length x width x height)

MIC5-SE:
305 mm X 240 mm x 98.7 mm (12.02" X 9.45" x 3.89")
(length x width x height)

Weight MICs:

8.2 kg (18.1 lbs)

MICs-SE:

3.9 kg (8.5 lbs)
Shape of device See chapter Overview Drawings on page 28
Mechanical environmental The housing is resistant to general atmospheric
conditions contaminations.

Resistant to gas engine lubricants.

Protection class: |
Protection: IP69

The specified protection classes and types are only
guaranteed if all external wiring connections are made in
accordance with the connector specification, all covers and
seals are installed as intended and the following tightening
torques are observed:

- All Mg bolts: 0.8 Nm to 1 Nm (0.6 lb-ft to 0.7 lb-ft)
- PG screw joints: 4.5 Nm to 5 Nm (3.3 lb-ft to 3.6 lb-ft)
-  Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2.2 lb-ft)

Always use a new seal when installing the service cover.

Standard single seal inserts Suitable for a cable with a diameter of 6 mm to 13 mm.
for PG screw joints

Multiple seal inserts for PG Suitable for up to three cables, each with a diameter of
screw joints 6 mmto7 mm.

Climatic environmental Housing surface temperature:

conditions —40 °C to +60 °C (40 °F to +140 °F)

Max. 85 % humidity without condensation
up to 3,000 m (9,842") above sea level
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4.1.3 Warning Notices on the Device

Validity of warning notices on device

connected to it.

Warning notice on the device German translation

£ MOTORTECH

The warning notices on the device are valid for the MIC5 and all components

French translation

WARNING! Read and WARNUNG! Lesen und
understand the installation verstehen Sie die
and operating manual prior to Installations- und

installing or making any Betriebsanleitung vor der

adjustments. Installation und bevor
Einstellungen vorgenommen
werden.

EXPLOSION HAZARD! Do not EXPLOSIONSGEFAHR! Keine

disconnect while circuit is Verbindungen l6sen, solange

live unless area is known to der Stromkreis aktiv ist,

be non-hazardous. For wiring aufler das Umfeld wird als

details refer to the operating  nicht explosionsgefdahrdet

manual. eingestuft. Hinweise zur
Verkabelung finden Sie in der
Betriebsanleitung.

CAUTION! Do not pressure ACHTUNG! Das Gerdt nicht

wash this device. Damageto  mit Hochdruck reinigen. Es

electronic components may konnte zu Schaden an den

result. elektronischen Bauteilen
fihren.

Warning Symbol on Device

Warning of hot surface

Rev. 01/2022

ATTENTION! Lisez et
comprenez le manuel
d’installation et d’utilisation
avant d’installer ou
d’effectuer une modification.

AVERTISSEMENT - RISQUE
D'EXPLOSION! Ne pas
débrancher tant que le circuit
est sous tension, a moins
qu'ilne s'agisse d'un
emplacement non dangereux.
Pour plus de détails de
cablage, veuillez consulter le
manuel d”utilisation.

ATTENTION! Ne pas laver cette
boite de contrdle en utilisant
un jet sous pression. Cela
pourrait endommager les
composants électroniques.
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I 4 Product Description

4.1.4 Product Identification — Labeling on the Device
The necessary numbers for unique product identification are on the device:

- Part number of the ignition controller (P/N)
- Arrangement number of the ignition controller (A/N)

- Serial number of the ignition controller (S/N)

Example MICs

= MOTORTECH

www.motortech.de

| P/N  66.00.540-20 |

c € |A/N  542.20.H000-000-AA-0 |

[S/N 01010001 |

4.1.5 Electrical Data

The MICs has the following electrical characteristics.

Feature Value

Power consumption MICs;:
max. 240 W at 24 V
MICs-SE:
max. 88 Wat 24V
Power supply Nominal voltage: 24 V DC
MICs;:
Operating voltage: 16.8 VDCto 32 VDC
MIC5s-SE:
Operating voltage: 10 VDCto 32V DC
Required current MICs:
current max. 14 A.
MICs-SE:

current max. 7 A.

An estimation of the power requirements can be found after this
table.
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Feature Value

Number of outputs MICs:
20 outputs
MICs-SE:
8 outputs
Firing angle The size of the firing angle depends on the max. overspeed. The

smallest firing angle per output bank can be calculated using the
following formula:

Overspeed [min']

50 x 360° x 2.8 ms

Ignition Angle =

Ignition frequency MICs:
With full energy output (all 20 ignition outputs with 500 m)), an
ignition frequency of 300 Hz as continuous load is possible. With
less ignition energy or in case of a brief overload, 360 Hz is
possible. The maximum output load of 180 W must not be
exceeded.

MIC5-SE:

With full energy output (all 8 ignition outputs with 500 m)), an
ignition frequency of 120 Hz as continuous load is possible. With
less ignition energy or in case of a brief overload, 150 Hz is
possible. The maximum output load of 75 W must not be
exceeded.

2-stroke engine:

Overspeed [min'"]

m x Number of Ignition Outputs

Ignition Frequency =

4-stroke engine:

1, Overspeed [min'

Ignition Frequency = ) 50 x Number of Ignition Outputs
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Estimation of Current Requirements
These current values are based on a nominal speed of 1800 rpm and 500 mj energy

MICs;:
Outputs Voltage Required current  Voltage Required current
10 24V 5A 16 V* 7A
16 24V 7A 16 V* 11A
20 24V 9A 16 V* 14 A

* Nominal voltage 24 V DC

MIC5-SE:
Outputs Voltage Required current
8 24V 4 A

Electrical Data for Inputs and Outputs
The inputs and outputs of the ignition controller have the following electrical data:

Inputs and outputs Values
Analog current input Current range: o mA to 20 mA (adjustable in MICT)
Input impedance: 27 Q || 1 yF
Analog voltage input Voltage range: o mA to 10 mA (adjustable in MICT)
Input impedance: 12.4 kQ || 200 nF
Auxiliary analog input 5V to 24 V/50 mA depending on the configuration in the MICT
supply voltage

Binary input (Start/Stop) Wiring

Input current: max. 20 mA

Ignition stop: o V to 0.8 V (low level)

Ignition release: 2.8 V to 32 V (high level)
Binary input (schedule A/B)  Wiring

Input current: max. 20 mA
Schedule A: 0 Vto 0.8 V (low level)
Schedule B: 2.8 V to 32 V (high level)
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Inputs and outputs Values

Binary input (GPI, general Wiring

purpose input) Input current: max. 20 mA

Low level: o Vt0 0.8V
High level: 2.8 Vto 32V

(Function dependent on the configuration in MICT, see
Inputs/Outputs — Inputs on page 114)

Go/NoGo and GPO outputs ~ One GPO (General Purpose Output) and one Go/NoGo output
Implementation as optical MOSFET relay
Maximum switching voltage: 32 V DC
Peak/steady current: max. 100 mA DC
Output power: max. 2.5 W
Internal resistance: 58 Q to 60 Q
Activation delay: 0.5 ms / max. 100 mA load
Deactivation delay: 0.2 ms / max. 100 mA load

If a short is found at the output, a safety circuit, which makes
the output highly resistive, is found at the output, so that the
current sets itself at 50 mA to 60 mA.

Signal LED Six LEDs are used as status indicators.

ASO output TTL level (5 V)
max. current: £ 10 mA

Pickup input Impedance: 10 kQ

The voltage supply for active pickup can be set using the
MICT from5Vto 24 V.

Max. frequency for the pickups: 10 kHz

The formula for determining the frequency of the pickups can
be found in the note following this table.

For a pickup output impedance of 120 Q to 10 kQ, the pickups
connected to the MIC5 may not have a higher voltage than
+40 V and the connected power may not exceed 1 W.

Ignition coil outputs Output voltage: max. 250 V

Output energy in normal operation: max. 500 m) (depending
on the ignition coils used)

Output energy in the start phase (boost): max. 600 mJ
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® Frequency of the pickups
. The frequency of the pickup is calculated as per the following formula.

Overspeed [min]

Frequency =
NOTICE quency 50

x Number of Pickup Events per Revolution

4.1.6 Interfaces
Depending on the device version, the following interfaces are available:

USB Interface

Compatible with USB 2.0

The Connector B version is only suitable for temporary data exchange and not for a
permanent connection.

Max. wire length 5 m (16.4")

CAN Bus Interface

Classical Extended Frame Format (CAN 2.0B)

As per 1S0O 11898 standard, 50 kbit/s to 1 Mbit/s
Transient-proof (automotive classification)

Max. 110 participants

Max. wire length 250 m (820') depending on the transfer rate

RS485 Interface

26

According to TIA-485-A (03/2003)
Max. 32 participants
Max. data transfer rate 9.6 kbit/s to 115.2 kbit/s

Max. wire length 100 m (328') depending on the transfer rate

® Pay attention to the wiring diagrams
Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
harnesses.
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4.1.7 Requirements for External Equipment
External equipment shall fulfill the input and output specifications of the MICs.
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4.1.8 Overview Drawings

Standard version of MICs5 with service cover.
Devices without a service cover have an input connector at the front of the device.
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89,5 mm (3.53")

115,2 mm (4.54")
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305 mm (12.02")
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4.1.9 LED Functions

O Status
O Firing
(O Pickup 1
(O Pickup 2
(O Pickup 3
O GPo
Labeling Function |
Status Firmware version 1.11.00000 and higher:
LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
For details, refer to the following overview.
Older firmware versions:
LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
The LED flashes yellow if a warning has occurred.
The firmware version of your device can be found in the MICT in the
window Runtime Data — Information. Refer to the section Runtime Data —
Information on page 145.
Firing LED lights up when the ignition is active (exception: during the self test).
Pickup1to3 Flashing LEDs indicate activity of the pickups.
GPO LED is on when the GPO is activated.

Rev. 01/2022 ”
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Indication via the Status LED (Firmware Version 1.11.00000 and Higher)

The flashing sequences shown below are repeated until the device has left the respective state
again. However, the flashing sequences are always executed to the end and are not interrupted
accordingly.

The status LED flashes green:

- Waiting for sufficient supply voltage
Fast flashing green/off 100 ms

- Synchronization/ Firing active
Flashing one time green 250 ms on, 750 ms off

- Ready for operation
slow flashing green/off 500 ms

- Bootloader - connection to computer started/ update mode
Flashing one time green 2,000 ms on, 250 ms off

- Firing locked
3 flashes green/off 250 ms, 750 ms off

- Configuration/ Wait for o RPM
6 flashes green/off 250 ms, 750 ms off

The status LED flashes red:

—  Critical error/ Assertion
fast flashing red/off 100 ms
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- Operating error — general/ System error
slow flashing red/off 500 ms

— Bootloader - faulty firmware
Flashing one time red 2,000 ms on, 250 ms off

— Operational error - pickup
2 flashes red/off 250 ms, 750 ms off

— Operational error - overspeed
4 flashes red/off 250 ms, 750 ms off

— Operational error - insufficient supply voltage
5 flashes red/off 250 ms, 750 ms off

The status LED flashes orange:

- Selftest
Flashing one time orange 250 ms on, 750 ms off

Rev. 01/2022 33



I 4 Product Description

4.1.10 Connections and Functions under the Service Cover
4 I
Power USB Pickup

57 8010 TR
Binary Output

T 2340506 120345678911

Power Connection for the supply voltage (see Input Wiring — Power
Supply on page 43)
USB USB connection for connecting to the computer

-
()
o
o
—3
=

wq

PB Button acknowledges errors, warnings and alarms or triggers a
reset of the ignition controller. Please refer also to the notice
below.

M31IS 3IIAIBS

3y} Japun suoiauny
pue suo13I3uu0)

A/B Potentiometer for the manual adjustment of the ignition timing.
The setting only has an effect if the potentiometer in the MICT is
activated.
Pickup Connection for the pickups (see Input Wiring — Pickups on
page 45)

CAN CAN interface for connecting external equipment (see Output
Wiring — CAN Bus Interface on page 53)

Binary Output Connection for binary outputs (refer to Output Wiring — Binary
Outputs (Go/NoGo, GPO, ASO) on page 50)

RS485 RS485 interface for connecting external equipment (see Output

Wiring — RS48s5 Interface on page 55)

Analog/Binary Input Connection for timing & safety devices (see Input Wiring — Timing
and Safety Devices on page 47)
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NOTICE

Rev. 01/2022

Behavior of the button PB

With the PB button on the device you can perform the following actions:

Press briefly (< 3 5):
Existing warnings are acknowledged.

Press longer than 3 s:

If no pickup signals are detected and an operational error exists, this
will be acknowledged together with all alarms. Warnings are
acknowledged in any case, even if no operational error exists.

Press longer than 15 s:
If no pickup signals are detected, the ignition controller restarts.

£ MOTORTECH
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I 5 Installation Instructions

5.1 Unpacking

Unpack the equipment, taking care not to damage it. Always place the device safely and
protected from falling over or falling down. Ensure that the operating manual is always stored
with the ignition controller and is easily accessible. Check the contents for completeness and
verify that the device type meets your application requirements.

Scope of Supply
The scope of supply of the MICs ignition controller consists of the following components:

— Ignition controller of the MICs series

— Installation set incl. four vibration dampers

— Ground strap

— Three multiple sealing inserts and five sealing plugs for PG screw joints

- Storage device (USB flash drive or CD-ROM) with software for configuring the ignition
controller

— USB interface cable for connecting the ignition controller to a computer

- Operating manual

5.2 Installation of the Ignition Controller

The installation of the MICs ignition controller is implemented on a fixed bracket e. g. on a wall
near the engine. Use the included rubber vibration dampers and the ground strap. The
installation location of the controller must be selected so that the distance to the pickups
installed on the engine ensures a reliable signal transmission to the ignition controller, and so
that there is adequate space for maintenance and repair work. The mechanical specifications
must always be complied with (refer to Mechanical Data on page 20). The ground strap serves to
ground the ignition controller and must be used accordingly. Ensure a flawless electrical
connection for this purpose.

Installation locations where strong vibrations or extreme ambient temperatures are present are
not permissible and result in the warranty being voided. The permitted temperature range is —
40 °C (40 °F) to +60 °C (+140 °F). To ensure sufficient cooling through the cooling body, the
device must be mounted so that the vanes of the cooling body are vertical and the hot air can
escape upwards unimpeded.

Risk of destruction!

The device must not be installed directly on or at the engine, as vibration
and heat may cause damage to electronic components. This also applies if
vibration dampers are used.
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5.2.1 Installation of the Vibration Dampers

£ MOTORTECH

There are two options for using the vibration dampers from the MICs's scope of supply. The hole

patterns can be found in section Overview Drawings on page 28.

Option A
1. Fasten the four vibration dampers H to the
ﬁ g 27 Nm /19 b-ft selected installation location. Use four
$ screws M8x16 B, four rim lock washers
; m8 Bl and four washers ms .

2. Fasten the MIC5 to the vibration dampers.
Use four washers M8 Ell and four lock nuts
ms .

» Fasten the ground strap to the ground
pin (see Installation of the Ground

Strap on page 38).
1

@\
- O
e:s

tEu > P
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Option B
1. Fasten the four vibration dampers Bl to the

P 27 Nm / 19 Ib-ft MICs. Use four screws M8x16 I, four rim

lock washers M8 EEll and four washers

ms AL
4]

2. Fasten the MICs to the selected installation
$ 4 location using the vibration dampers. Use
four washers M8 EEd and four lock nuts
! ms B

» Fasten the ground strap to the ground
pin (see Installation of the Ground
Strap on page 38).

= O

D B2 8m 19 b

5.2.2 Installation of the Ground Strap

1. Fasten the ground strap Bl to the MICs
E ground pin. To do so, use one washer
3 M6 B, one tooth lock washer A6 Bl and
one poly lock nut M6 4}

2. Connect the ground strap to one of the
sides suitable for grounding.

» You can wire the ignition controller as
described in section Wiring of the
Device on page 40.

(schematic representation)
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5.3 Determine the Installation Location of the Pickup
Set the positions of the pickups depending on engine type and application. All angle reference
information is based on:

TDC 1st cylinder / compression cycle

The installation location for the pickups must have adequate mechanical strength and must not
exceed the specified temperature ranges. The pickups are designed for the appropriate use
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate
the calibration of the sensor. Comply with the pertinent regulations for the wire routing.

For the exact positioning of the individual pickups, refer to the examples given in the drawings
(see section Input Wiring — Pickups on page 45).
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6.1 Input and Output Wiring on the Controller

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 20.

After the service cover on the device has been opened, e.g. to complete the
wiring, it must be refitted so that it is in the same alignment as it was prior
to opening. The USB connection must always be below the service screw. If
the mounting is rotated, maintaining the indicated protection classes, as
well as compliance with CSA-Class I, Division 2 (Group C, D) is impaired.

Operational safety!

Improper wiring using the PG screw joints impairs the compliance with the
specified protection classes as well as with CSA Class |, Division 2 (Group C,
D). Please adhere to the following points:

— Do not pass any cables without matching sealing inserts through the PG
screw joints.

— Asealing insert must be used in every PG screw joint.

— Unused bore holes for the sealing inserts must be sealed using sealing
plugs.

— The PG screw joints must be adequately tightened.

For additional information on PG screw joints and sealing inserts please
refer to Mechanical Data on page 20.

Assignment of the wire colors

Take the assignment of the wire colors of the wiring harness for the input
and output wiring from the wiring diagram enclosed with the wiring
harness.

Pay attention to the wiring diagrams

Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
harnesses.
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6.1.1 Input Wiring

For the standard MICs version, the connections for the input wiring are located on the connector
strip below the service cover (see Connections and Functions under the Service Cover on page
34). The wiring to the connector strips is fed through the PG screw joints at the device front.

For device versions without a service cover, the input wiring is established using a 35-pole input
connector at the device front.

35-Pole Input Connector

35-pole input connector (outside view)

Assignment of the Connections
The table contains the connection assignment of different MIC5 versions. The wiring examples
contained in this operating manual refer to devices with a service cover and connector strip.

Pin designation Connection no. on connector strip  35-pole connector
L — (negative pole) Power 1 B
L+(24V) 2 A
Pickup 1 Power Pickup 1 C
Signal 2 D
GND 3 E
Shield 4 F
Pickup 2 Power 5 G
Signal 6 H
GND 7 J
Shield 8 K
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Connection no. on connector strip  35-pole connector

Pin designation

Pickup 3 Power
Signal
GND
Shield

CAN Display  Hi
Com
Lo
Shield

CAN Hi
Com
Lo
Shield

Go/NoGo +

Go/NoGo -

GPO +

GPO -

ASO +

ASO -

ASO Shield

Timing Uin +

Analog GND

Analog PWR

Timing | in -

Timing I in+

Analog Shield

Start/Stop +

Schedule A/B +

GPI1 +

Binary Com

Binary Shield

CAN

Binary
Output

Analog/
Binary
Input

9
10

11

12

X =< c 4 »nw =®m W =Z2 = -

- Do o

=2}
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RS485

Pin designation Connection no. on connector strip 35-pole connector
X+ RS48s 1 Y
™>- 2 z
Com 3 a
RX + 4 b
RX - 5 C
Shield 6 -

6.1.2 Input Wiring — Power Supply

NOTICE

Rev. 01/2022

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating
manual.

Design of power supply

For the power supply, an overcurrent protection mechanism must be set up
with a circuit breaker (MICs: 20 A DC, MIC5-SE: 16 A DC can both be set with
tripping characteristic B), which allows switching off. When selecting the
circuit breaker, the conditions of the installation site and the ambient
temperature must be considered. The circuit breaker must be easy for the
user to access and marked as a disconnecting device for the ignition
controller.

If the power is supplied via a power supply unit, the following specifications
must be observed additionally:

MICs:
— Voltage: 24 V DC; Current: at least 30 A

—  Wiring: at least 2.5 mm2 cross-section

MIC5-SE:
— Voltage: 24 V DC; Current: at least 25 A

—  Wiring: at least 1.5 mm2 cross-section
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L 2 24V DC (nominal voltage)

1 Battery Generator Control unit
2 Power supply
———————————o |-
— o L+ E—— —
s
(LD (LD 3 Battery Charger
- +
= f—-o0
~v
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6.1.3 Input Wiring — Pickups

Example Configuration (one Active, two Passive Pickups)

~ o Camshaft

Crankshaft

j Ia u (Reset)

Crankshaft

()
)

w O w©
5 3 5 3
@ [

L ‘ 1
Pickup 1 Pickup 2 Pickup 3

Power

No ()
Shield [(==).
(<)

Signal e
N0 |(2)
shieid | (&)

| Shield
Power

Power 6

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH
pickups. Please note that additional fine-tuning is required for every pickup position due to the
different conditions of the engines.
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One revolution of the pickup changes the distance as follows:

M12x1 1revolution 2 1 mm (0.04")
5/8"-18 UNF 1 revolution 2 1.41 mm (0.05")
3/4"-16 UNF 1 revolution 2 1.59 mm (0.06")

Allocation of the Wire Colors (Example Configuration)

Camshaft
PIN Designation Wire color
1 Pickup 1 Power Brown
2 Pickup 1 Signal black
3 Pickup 1 GND blue
4 Pickup 1 Shield Shield
Crankshaft (Reset)
PIN Designation Wire color
6 Pickup 2 Signal Flywheel with pin Flywheel with hole
White Brown
7 Pickup 2 GND Flywheel with pin Flywheel with hole
Brown White
8 Pickup 2 Shield Shield
Crankshaft
PIN Designation Wire color
10 Pickup 3 Signal White
11 Pickup 3 GND Brown
12 Pickup 3 Shield Shield

For problems with the pickup signals, refer to the section Pickup Input Errors on page 167.
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Adjusting the pickup sensitivity

Depending on the type of impulse source (interference), it may be necessary
to increase the pickup sensitivity to ensure that the resultant signal
strength is sufficient for reliable operation. You can make these
adjustments in the MICT. Refer to the section Engine — Pickups on page 100.

Aux. pickup supply voltage

An auxiliary supply voltage for active pickups can be configured using the
MICT. The voltage can be set in the range from 5 V to 24 V and is supplied at
the connections Pickup 1 Power to Pickup 3 Power. Refer to the section
Engine — Pickups on page 100.

6.1.4 Input Wiring — Timing and Safety Devices

Example Configuration

—t} *) See subsequent drawings for details

x = bridge for permanent authorization
") (must be removed for external ignition
authorization)

— Switch Start/Stop
>y
open Ignition — OFF
—0//0—1 .
closed Ignition — ON
1 9 Switch A/B
open Schedule A
1)02)(3)(4)(5 7)(8)(9)(10
|O @ ®| closed Schedule B
c 28 L 3 & =5 3B
S8 o288 35S 5
2 & o £ £ =9 = 2 5 =
E 2 2 EES E T 5 2
= < = = z w £ &
w
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I 6 Wiring of the Device

Two-Wire Transmitter

Analog Power

l Timing l'in +

48

Timing lin -

Analog GND
Analog Shield

Four-Wire Transmitter

A

+V

+1

Analog Power

Timing | in +

Auxiliary analog input supply voltage

\ , Timing lin -
Analog Shield

An auxiliary supply voltage for the analog inputs can be configured using
the MICT. The voltage can be set in the range of 5 to 24 V and is made
available on the connection Analog Power. Refer to the section Timing —

Analog Inputs on page 104.
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I 6 Wiring of the Device = MOTORTECH

Wiring MICs ignition controller and DetCon detonation control system

The following diagram shows an example of the wiring of a MICs ignition
controller with a DetCon detonation control system in cases where the

T T ’ana.l(.)g ct{rn‘ent sgnal (4-20 mA) at the output / out is to be used for the
ignition timing adjustment.

= +
Ehc e PR R R e
E 8 8 EE 8 5 5 g & B2 5
F <« < F F < ® & G @ o ignition
OOOOOEOEO®@ )]  controler
L]
DetC
IOOOOOCOOOOOOD) detonstion
t le,*t E 58 2PE £ o0+ control system
B3 E S 57889 4
ow gg uEJ:%

Furthermore, the limits of the analog current input will need to be set at
4 mA to 20 mA and the auxiliary supply voltage of the analog inputs to 24 V
in the MICT. Refer to the section Timing — Analog Inputs on page 104.

The timing is transmitted by MICs via the auxiliary synchronization output
(ASO) to the DetCon, and will need to be wired and configured accordingly.
Refer to the section Output Wiring — Binary Outputs (Go/NoGo, GPO, ASO)

on page 50.

@ General purpose input GPI
The general purpose input GPI can be assigned various functions via the
configuration. Refer to the section Inputs/Outputs — Inputs on page 114.

NOTICE
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6.1.5 Qutput Wiring — Binary Outputs (Go/NoGo, GPO, ASO)

Example Configuration

oL+
[« |-
*) DetCon or other external device (for wiring
|:K2 I--- of the DetCon, see following example)
K1 =Go/NoGo relay
K2 = GPO relay
" L27VDCto32VDC
o L-
+ I + I + 1 %
Q e O O O o 2
2582245
5 B
3 O
L+ L+
lom +
A | o Qut -
$ E‘ |“§] Relay Al
m — l
_5] Relay
o Qut + A2
TOui—
L- L-

(L27VDCto32VDC)
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I 6 Wiring of the Device = MOTORTECH

DetCon connection

Connect the ASO output on the DetCon to the connections in A and in B on
connector Synchronization.

EXAMPLE
DetCon

Synchronization

inA
inB

LV

GoNogo+ [
GalNoGo - |(~)
epo+ |(=)
ero- [()
Aso+ [(=)
As0- |(=)
shield (=)

6.1.6 Wiring — PowerView3

Connect the PowerViews3 visualization unit to the MIC5 as follows.

CAN Connection between Ignition Controller and PowerView3

As shown in the following illustration, you can connect the PowerViews directly to the
MOTORTECH ignition controller using the CAN cable delivered with the PowerViews. To do so,
you need to insert the connector in the CAN interface on the PowerViews. On the ignition
controller, connect the color-coded conductors of the CAN cable to the correct CAN interface
connections.
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Connector for CAN
interface on PowerViews

Shield
Term
Lo

Hi
Term
Com

green
brown

CAN interface on the
| ignition controller

OOOO

CAN Hi @ N\ white

0]0)

CAN Shield (=),

£
=1
(&]
=
<
Q

—

120Q

PowerViews Power Supply via the Ignition Controller
If you use a MOTORTECH ignition controller with a service cover and connector strip, you have

the option of supplying power to the PowerViews3 via the ignition controller. A special connector
isincluded in the PowerView3's scope of supply. The connector for the voltage supply of the
ignition controller must be replaced by this one.

Connector supplied with Connector supplied with
the ignition controller: PowerViews:

Proceed as follows:
1. Disconnect the power supply to the ignition controller and, if necessary, to the PowerViews.
2. Remove the connector for the power supply from the ignition controller.

3. Negative terminal: Disconnect the conductor from the contact B and insert it into contact
of the connector provided with the PowerViews.
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4. Positive terminal: Disconnect the conductor from the contact B and insert it into contact B
of the connector provided with the PowerViews.

5. From the PowerViews power supply cable, plug the L— wire (white) into contact B ror
plugging into the contact, use a wire end ferrule provided with the PowerViews.

6. From the PowerViews power supply cable, plug the L+ wire (brown) into contact B ror
plugging into the contact, use a wire end ferrule provided with the PowerViews.

7. Insert the connector provided with the PowerViews into the power supply connection of the
ignition controller.

8. Insert the connector at the other end of the PowerView3 power supply cable into the
PowerView3 power supply connection.

9. Connect the device's power supply.

» The power supply of the PowerViews is now provided through the connector on the
ignition controller.

6.1.7 Output Wiring — CAN Bus Interface
The product must be connected to a CAN bus as follows:

First device Second-to-last device
£ E 3z = = =
£ 38 35 £33
CAN Bus
= o ) // )
£ 8 35 R=120Q \\ R=120 Q

[e]elelolelolele]
(‘3 = < 0
3 ° z
Q
Second device Last device

Notice: The CAN-Bus connectors 1-4 are currently unavailable.
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54

CANopen® protocol

If you require information on the CANopen® protocol, contact your
MOTORTECH contact person.

CAN bus wiring

Note the following when connecting the CAN bus:

— Each bus end must be fitted with a terminating resistor of 120 Q (see

drawing).

— The maximum wire length depends on the bit rate:

Bit rate

1 Mbit/s
800 kbit/s
500 kbit/s
250 kbit/s
125 kbit/s
50 kbit/s

Maximum wire  Maximum length

length of a stub
25m (82') 1.5m (5"
50 m (164") 2.5m (8"

100 m (328") 5.5 m (18")
250 m (820') 11m (36')
500 m (1,640") 22 m(72")

1,000 m (3,280") 55 m (180"

Maximum length of
all stubs

7-5m (25
12.5 m (41")
27.5m (90
55 m (180")
110 m (360")

275 m (902")

— Only use cables that are specified by the manufacturer for use in the

CAN bus.
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6.1.8 Output Wiring — RS485 Interface
The RS48s5 interface can be wired as two-wire or four-wire wiring and twisted cables must be
used. With both variants the load resistance (Rr=120 Q) is the characteristic impedance of the

cable.

Two-Wire Wiring

First device

RX +
RX -

TX -
TX +

Four-Wire Wiring

First device
(Master)

RX +

RX -
™-

TX+

Rev. 01/2022
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Last device
RX +
RX -
iR AN )
TX -
TX +
Second device Second-to-last device
Last device
(Slave)
/L X+
i ( i3
T -
NN e
: )) 2
7 / RX +
+ 1 1 - + 1 1 +
- EopE K

Second device
(Slave)

Second-to-last device
(Slave)

55



I 6 Wiring of the Device

Connection on the Ignition Controller

RS485

TX +
TX -
Com
RX +

RS485TX + 6 A

Rs485TX - ()

Rs485 Com [(=2)

RS485 RX + (=)

RS485 RX - [(=n), RX -
shield [(=2) JJ

i Wiring of the RS485 interface
. Follow these instructions for the RS485 interface wiring:
— Max. 32 devices can be connected to a bus.

NOTICE — The maximum wire length is 100 m (328') depending on the transfer
rate.

— Each bus end must be fitted with a terminating resistor with 120 Q in
each pair of leads (as indicated in the drawing).
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6.2 Ignition Coil Wiring

Ignition coil wiring

In the MICT there are two types of wiring with predefined output
configuration supported in the engine database for many engines:

— Wired in straight order

— Wired in firing order

For information on straight order wiring refer to Straight Order Wiring of the
Ignition Outputs on page 6o and Engine — Parameters on page 92.

For wiring in firing order, the first cylinder in the firing order is connected to
the A1 output, the second to B1 (A2 for one output board), etc.

If a different wiring was implemented, the output configuration in the MICT
must be adapted accordingly. Please note that the wiring cannot be
checked by the software (see section Engine — Parameters on page 92).

® Conductor cross-section for primary wiring
If you do not use a harness manufactured by MOTORTECH, the primary
wiring must have a conductor cross-section of 1.5 mm2.

NOTICE
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6.2.1 Ignition Coil Wiring for a 35-Pole Connector
The table shows the pole assignments for the output connector.

&

35-pole output connector (outside view)

Pole | Output

A Output A1
B Output B1
C Output A2
D Output B2
E Output A3
F Output B3
G Output A4
H Output B4
J Output Ag
K Output Bg
m Ground

58

Pole

=< c 4w =xx v ==z

Bo oA
oCGofofoloC
oNoMol oKoJ oH
oWoVolUoT oSoRoP
0coboaoZoYoX
ohogof oeod

Okg 10

Output
Output A6
Output B6
Output A7
Output B7
Output A8
Output B8
Output Ag
Output Bg
Output A10
Output B1o
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6.2.2 Ignition Coil Wiring 17-Pole and 14-Pole Connector
The table shows the pole assignments for the output connector.

8

—

17-pole output connector and 14-pole output connector (MICs, outside view)
The MIC5-SE has only one 17-pole output connector.

Pole Output (17-pole) Pole Output (14-pole)
A Output A1 A Output B1
B Output A2 B Output B2
C Output A3 C Output B3
D Output A4 D Output B4
E Output As E Output Bs
F Output A6 F Output B6
G Output A7 G Output B7
H Output A8 H Output B8
J Output Ag | Output Bg
K Output A10 J Output B1o
N Ground N Ground
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6.2.3 Straight Order Wiring of the Ignition Outputs

Risk of damage to engine

If you use MOTORTECH wiring rails for straight order wiring, it is absolutely
necessary that they are correctly selected and installed for the respective
engine. Even a rotated installation can cause serious damage to the engine,
for example.

Straight order wiring, along with wiring in firing order, is supported by the MICT for many
engines with predefined output configurations in the engine database. That means that if the
wiring is carried out accordingly and the option Wired in Straight Order is selected in the MICT,
no other adaptation of the output configuration is necessary.

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are identified with Connector Pin 1 to Connector Pin X.

- Make the wiring of the ignition controller corresponding to the instructions in the following
sections (for example with an open wiring harness or via a junction box).

Execution of straight order wiring is dependent on the following factors:

— One or two output banks in the ignition controller

- Thetype of engine (in-line or V-engine)

- Alignment of the wiring rail(s)
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6.2.4 Straight Order Wiring of the Ignition Outputs — Overview

MICs
The following table contains the allocation of the MIC5 outputs to the cylinders.

In-line engine V-engine
Connector*  Coil** Connector*  Coil**

Output A1 1 1 1 1
Output B1 1 2 2 1
Output A2 1 3 1 2
Output B2 1 4 2 2
Output A3 1 5 1 3
Output B3 1 6 2 3
Output A4 1 7 1 4
Output B4 1 8 2 4
Output As 1 9 1 5
Output Bg 1 10 2 5
Output A6 1 11 1 6
Output B6 1 12 2 6
Output A7 1 13 1 7
Output B7 1 14 2 7
Output A8 1 15 1 8
Output B8 1 16 2 8
Output Ag 1 17 1 9
Output Bg 1 18 2 9
Output A10 1 19 1 10
Output B1o 1 20 2 10
Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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MICs-SE
The following table contains the allocation of the MIC5-SE outputs to the cylinders.

In-line engine V-engine

Connector*  Coil** Connector* Coil**
Output A1 1 1 1 1
Output A2 1 2 2 1
Output A3 1 3 1 2
Output A4 1 4 2 2
Output Ag 1 5 1 3
Output A6 1 6 2 3
Output A7 1 7 1 4
Output A8 1 8 2 4
Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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1 7 Functions =MOTORTECH

The ignition controllers of the MICs series include freely configurable safety and auxiliary
functions that, amongst others, can shut down the engine in case of fault.

Angle indications in the operating manual

All angles in this operating manual are given in °crankshaft. Exceptions are
clearly identified.

7.1 Pickup Sensitivity

To increase the signal interference distance, the sensitivity of the pickup signal inputs can be
changed for suitable pickup signals. This setting can be implemented individually for each
input. For this purpose, a pre-trigger voltage can be set below which signals are interpreted as
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus
result in a low pickup sensitivity level.

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine —
Pickups on page 100.

7.2 Monitoring of Pickup Signals

The MIC5 monitors the pickup signals. Any other errors are displayed in the MICT. For more
information on the errors, please refer to the overview in the section entitled Pickup Input Errors
on page 167.

7-3 Go/NoGo

The binary output (Go/NoGo) is a potential-free output. It is closed during firing and opens when
the ignition switches off. The max. switching current is 100 mA. The output can drive an external
relay that e.g. opens a gas valve.

The following errors can cause the ignition outputs to shut down:
- Overspeed

- Pickup error

- Error HV power supply

— Failure of the output monitoring

- Overload/temperature shut-down

- Alarms

- Insufficient supply voltage (Low Power)



I 7 Functions

Use master control

The outputs of the MICs are not SIL compliant. Therefore, always use an
additional master control for safety-critical applications.

7.4 lgnition Timing Adjustment
The ignition controller has several functions for the timing correction.

Influences on ignition timing

Be aware that the actual timing of the engine can also be influenced by
external signals (e.g., analog current or voltage input).

Operational safety!

The MICs ignition controller must first be correctly configured for the engine
being used before you can start the engine.

An incorrect configuration can result in damage to the engine.

The figure below gives you an overview of the different functions of the timing correction, which
will be explained in more detail in the subsequent sections. Functions that can be
activated/disabled via the MICT are marked by a switch symbol. Depending on the device
version, some functions might not be available.
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Per schedule:

| Base Timing

[Speed Curve I_/_’(.D

| Analog Voltage Input |_/_>@
| Analog Current Input I—/—}@

| Potentiometer I—/—}@

Global:

| Ignition Timing Correction |—>@
Per cylinder:
Cylinder Individual ~ |— | i 1iteq by the ————»®
Offset

min./max. Cylinder
Individual Offset

Limited by the
min./max. Timing
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7.4.1 Manual Timing Correction

The ignition controllers of the MICs series include two permanently installed overwind-protected
potentiometers for manually correcting the ignition timing. The max. range is defined with the
corresponding limits that are set by the user. Potentiometer A adjusts the ignition timing of
schedule A and potentiometer B adjusts the igniting timing of schedule B.

7.4.2 Analog Inputs

The timing point control can be adjusted with a linear current signal. This signal can be
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a
detonation controller.

With the analog process signal (current loop signal) at the analog current input, the timing point
can be offset in the advanced or retarded direction within a defined range.

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the
corresponding input.

The levels of the analog inputs can be set in the range from o mA to 20 mAand o Vto 10 V. You
can make this configuration with the MICT. Refer to the section Timing — Analog Inputs on page
104.

At the voltage output (Analog Power), a configurable auxiliary voltage is supplied that can be
used for supplying power to external sensors.
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Configuration examples

In this example the analog inputs are configured in the Timing — Analog
Inputs window as follows:

EXAMPLE — Input current: 4-20 mA
— Input voltage: o-5V

Characteristic 4-20 mA / o-5 V - Ignition timing adjustment toward
retarded.

BTDC
A

40° 7 4mA oV

0 —t
30 Base Timing 30° BTDC

15° retarded ignition
15° _|i8
20mA 5V

5o

»

o® bl

Characteristic 4-20 mA / o-5 V - Ignition timing adjustment toward
advanced.

BTDC
A
40° T 20mA 5V

0 —t
30 15° advanced ignition

mi o
o | Base Timing 15° BTDC

4mA oV

5o

o® bl

7.4.3 Cylinder-to-Cylinder Alignment
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders
to optimize their combustion.

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to
the chapter Cylinder Individual Offsets on page 153.
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Use of measuring unit

Use this setup option only if a suitable measuring unit is available for
determining the optimum timing point, so that the result of a change can be
assessed immediately.

7.4.4 Speed Curve

To optimize the ignition, for example, during the start phase of the engine, a speed curve can be
defined for the MICs ignition controllers. To create this curve, up to eight adjustable speed
points are available.

You can configure the speed curve with the MICT. Refer to the section Timing — Schedule A/B -
General on page 106.

7.4.5 Ignition Timing Correction

Via the ignition timing correction, the global ignition timing, limited by the timing limits of the
current schedule, can be adjusted. Refer to the section Runtime Adjustments — Timing on page
149.

7.5 Firing Angle
The min. distance between two ignition angles depends on the overspeed. The smallest ignition
spacing per output bank can be calculated using the following formula:

Overspeed [min”]

50 X 360° x 2.8 ms

Ignition Angle =

7.6 HV-Power Supply Error Monitoring
The voltage applied is monitored for excess voltage or low voltage by the integrated power
supply. For both errors a Power-Fail error is saved and the device shuts off.

7.7 Output Monitoring

Electronic switches are used for the ignition outputs of the MICs ignition controller If one of
these switches is defective, this would lead to a primary short or a primary open output. This can
cause problems when operating the engine or can damage the engine. The function of the
outputs is therefore monitored and errors that occur are displayed in the runtime data in the
MICT or can be transmitted via field buses. Different alarms are available for monitoring the
misfire rate. It can also be defined that the ignition is switched off in the event of output errors.
Refer to the section Inputs/Outputs — Alarms on page 110.
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7.8 Schedules A/B

The MICs ignition controllers offer two separate schedules for the parameterization of the
ignition timing and energy.

By closing input Schedule A/B, the listed parameter settings for schedule B can be selected. A
possible application for this is e.g. operation with different gases. If only one schedule is
configured, this is used regardless of the switch position.

You can configure the schedules with the MICT. Refer to Timing — Schedule A/B — General on
page 106 and Timing — Schedule A/B — Energy on page 108.

Operational safety!

If you use schedules A and B, the advanced timing point should be linked to
schedule B (switch closure). If a wire ruptures, schedule A is automatically
selected with the retarded (and thus safer) timing point.

7.9 Alarms

The MICs ignition controllers include 16 freely configurable alarms in total. These alarms can be
freely allocated to the general purpose output (GPO) and set depending on the following
functions:

- Limit for speed exceeded/not reached

- Limit for engine operating hours exceeded/not reached

- Limit for spark plug operating hours exceeded/not reached
- Warning active

- Error active

- Limit for temperature exceeded/not reached

- Limit for supply voltage exceeded/not reached

- Limit for global ignition timing exceeded/not reached

- Limit on the analog voltage input exceeded/not reached

— Limit on the analog current input exceeded/not reached

- Limit of the minimum spark duration exceeded/not reached
- Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) above threshold
- Consecutive misfires (primary, single output) above threshold

- Misfire rate (secondary, individual output) above threshold
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- Misfire rate (secondary, all outputs) above threshold
- Misfires per second (secondary, all outputs) above threshold

- Consecutive misfires (secondary, single output) above threshold

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer
to the section Inputs/Outputs — Alarms on page 110.

7.10 GPO: General Purpose Output
The function of the general purpose output (GPO) can be set as desired as normally closed or
normally open. The GPO can be used for the freely definable alarms.

You can enter the settings for the general purpose output with the MICT. Refer to the section
Inputs/Outputs — Alarms on page 110.

7.11 ASO: Auxiliary Synchronization Output

The ASO is an output of the MICs for synchronizing the MICs ignition controller and a connected
control unit. The possible applications include detonation control, valve control, and fuel
injection control.

The ASO signal is low-active, i.e. the pulse width is defined as the time difference between the
raising and falling edge (pulse width = traising — trating). The raising edge of the signal marks the

configured engine rotation angle. With the variable pulse width, the values can be allocated to
the engine rotation angle. A maximum of 20 pulses can be configured for this purpose.

The pulse width is known at the time of the active edge, as the falling edge of the signal
precedes the raising edge by the value of the pulse width. The controller calculates the duration
of the falling edge from high-level to low-level and then back to the starting value of the high-
level.

The ASO signal can be inverted via the configuration. It will then be high-active.

You can configure the auxiliary synchronization output with the MICT. Refer to the section
Inputs/Outputs — ASO1 (Auxiliary Synchronization Output) on page 112.
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EXAMPLE

Rev. 01/2022

Application of the ASO signal
The following example will illustrate the application of the ASO signal:
— Four-stroke engine with 6 cylinders

— Ignition angle 120° - 120°

Synchronization between MIC5 and Valve Controller

Ignition angle in ASO signalin Pulse duration in
°crankshaft °crankshaft ps

1 0/720 718 160

2 120 118 80

3 240 238 8o

4 360 358 80

5 480 478 8o

6 600 598 80

Schematic Representation (Standard Settings)

Level

*) active edge

The valve controller should receive the active edge of the ASO signal before
the top dead center of a cylinder. The first pulse duration should be twice
as long and thus mark the beginning of a cycle. The ASO signal generated
by the MICs increases by 2° each time before the ignition signal from Low
to High, as can be seen in the schematic drawing. This edge is analyzed by
the valve controller as the active edge.

The ASO signal drops in accordance with the configured pulse duration
from High to Low before the active edge. The valve controller then has
already measured the pulse duration of the active edge and can provide
information on the allocation of the signal. In the example shown here, the
first cylinder is marked with a pulse width of 160 ps versus 8o ps for other
cylinders. If the valve controller measures a pulse width of 160 ps, the
subsequent signal is therefore allocated to the first cylinder. The next
signal then corresponds with the second cylinder in the ignition sequence,
etc.

£ MOTORTECH
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7.12 Ignition Energy
The ignition energy can be set separately for the start phase and normal operation. Here
different settings can be made for schedules A and B.

You can configure the ignition energy with the MICT. Please refer to the section Timing —
Schedule A/B - Energy on page 108.

7.13 Access Control
The MICs has four operating levels, three of which can be secured with different PINs. As a
default setting, the access control is not activated. If the access control for the MICs is activated,
it is independent from the access levels that control authorizations within the MICT.

Access control in the MICT and on MIC5

A user is logged in to the Advanced Service access level on the MICT. He
changes a configuration and would like to download the change to the

EXAMPLE

MICs. Although he has the full authorization set in the MICT, he is prompted

to log in with the PIN for the Level 3 (Master) on the MICs.

A variety of functions are at your disposal in the four operating levels of the MIC5 . The figure

below illustrates this:

Level o: Read Only

Runtime Data

All

Access Control

Login

Level 1: Operator

Level 2: Service

Runtime Adjustment

Level 3: Master

Runtime Adjustment

Timing
Energy

Commands

Commands

Reset Paosition

Configuration

Alarm Commands
Error Commands
Misfire Counters

Set Engine Hous
Set Spark Plug Hours

Timing

Cylinder Individual
Offsets

Download to Device

Access Control

Self Test

All

72

Reset All PINs
Enable Access Control
Disable Access Control
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£ MOTORTECH

The following functions are available on the different levels:

Level o (Read Only)
Enables read-only access for all users.

Level 1 (Operator)
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on
this level.

Level 2 (Service)

Only the Service level has access to modifications of the runtime adjustments for Timing and
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual
Offsets and the Settings for Self Test can also be executed in this operating level.

Level 3 (Master)

On this level, the Master can, in addition to the other adjustments, modify the Reset Position
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to
transfer a configuration to an ignition controller.

For information on the access levels in the MICT, refer to the section Access Levels in the MICT on
page 75.
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MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. With the MICT, you can
configure your ignition controller, and you can view and adjust the operating data of your
engine. When working with the MICT, you can press the F1 key at any time to access context-
sensitive help.

If you are using a different version of the MICT than shown in the following sections, the scope of
functions may differ.

8.1 MICT System Requirements
For the installation of the MICT, the following minimum requirements must be fulfilled:

— x86-compatible computer, at least performance class Intel Pentium 4 with 2 GHz
- 128 MB free RAM

- 250 MB free disk space

— USBinterface 1.1 or higher

- Display with a resolution of at least 1440 x 900 pixels (WXGA+)

- Microsoft® Windows 7, Windows 10

8.2 MICT Installation
The software for the installation of the MICT is on the storage device (USB flash drive or CD-ROM)
provided with the ignition controller.

To install the MICT, proceed as follows:
1. Start the installation:

— Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine of the MICT
via Software -» Install MICT.

— Directly from the storage device:
Start the installation routine of the MICT directly. It is on the storage device in the
subdirectory Installation and for example named as follows: MICT-2.42.2-setup.exe.

2. Run the installation.
Follow the instructions of the installation routine. Note that the license agreement terms
must be accepted before using the MICT.

3. Install the USB driver via the menu as well or directly from the storage device.

— Viathe menu:
Software -> USB Drivers -» Install USB Drivers

— Directly from the storage device:
Start the exe file in subdirectory Drivers(e.g. CDM21226_Setup.exe).

> The MICT is set up. You can connect your PC to the ignition controller via the USB
interface.
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8.3 Access Levels in the MICT
You can open the MICT on your computer via Start -> Programs -> MOTORTECH -> MICT 2.x.x -»
MICT 2.x.x.

After opening the MICT, select the access level for which you have clearance. The access level
controls the options you have at your disposal in the MICT. The password required for access
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on
page 169).

¥ Change Access Level x

Access Level
Read Only
O Customer
() service
(O advanced Service

Password:

=

The following access levels are available:

Read Only

On this level, the user can open a configuration and transfer it to the device. However, he
cannot make changes to the configuration. The user has read-only access to all other
settings.

Customer
This level enables the configuration of the basic functions required for operation in addition
to the read-only function.

Service
This level contains all functions for a standard installation.

Advanced Service
This level offers full access to all functions of the MICT and is enabled and accessible for
specially trained personnel only.

The following sections describe the options at your disposal with the Advanced Service access
level. If you have registered for a different level, you cannot execute all functions shown.
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8.4 Configuration Pages (Overview)
The configuration pages are divided into the following sections:

B unnamed.mics (MICS 5x2.20) - MICT

— =] s
u—-5|= Device Settings Document Tools Help
B4 QW52 i%SE0
Configuration Page il e ks
~ Engine Heidean -
71 Parameters Engine Manufacturer Series Type [New Engine Configuration|
- CledetNamﬁ AR Engine Type: 4-<troke engine
Ignition Outputs Bergen Diesel
| Ignition Coils Caterpillar
3 Pickips Clark i n
Cooper Bessemer
y ™
Analog Inputs
= el Guascor
&} thmleﬁ Ingerscll Rand
| General | Jenbacher
} Enerqy Liebherr
~ 5] ScheduleB ey
g |Hozdberg
] General Cifoe
Energy Sequence
| Miscellaneous Superior
© Inputs/Outputs Waukesha
) Alarms
| AsO1
1 Inputs
~ Miscellaneous
I] Communication
B Information A

MOTORTECH liability for in the engine database. Please contact MOTORTECH if
discrepances are found.

1f your engine is not avakable i the kst contact MOTORTECH service please.

Q) COM4 D MIC5 5:2.20 (1.9.1 [0000caD1]) ADV. SERVICE Full Access Version: 2422 -_-—H

Menu bar

Toolbar

Navigation bar
Configuration section
Status bar

The functions in the menu bar, navigation bar and the toolbar as well as the configuration
section will be described in the following.
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The status bar provides you with the following information (from left to right):

Status display
Indicates whether a connection is established with the device:

— Green: Connection established
- Red: The connection was interrupted and is being restored

- Gray: The connection is not established and is not being restored

Indication of the interface being used for the connection to the device
Indication of the device ID
Indication of the access level of the user in the MICT

Indication of the operating level for the MICs if access control has been activated and the
user has logged on with a PIN.

Indication of the MICT program version

8.5 Menu Bar and Toolbar

The following functions are available to you via the symbols on the toolbar and the entries in the

menu bar:
Symbol Menu Function
File -> New Creates a new configuration.
q\v File -> Open Opens an existing configuration.
File -» Save / Saves the current configuration.
E File -> Save As
File -> Recent Documents The last five configuration files used are
offered for selection.
File -» Close Closes the current configuration.
File -> Open trace Opens a runtime data record (trace file). Refer
to the section Runtime Data on page 118.
File -» Open pickup trace Opens a saved record of pickup signals
(putrace file). Refer to the section Pickup Trace
on page 83.
@) File -> Change Access Level Changes the MICT access level for accessing
( the configuration data and functions.
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Symbol Menu

File -» Print

(T )
h

ey File -> Print To PDF File
File - Print Preview
File -»> Quit

Device -» Connect

E Device -» Disconnect

% Device -> Download to device
8 :;“J
% Device-» Upload from device

Device -» Runtime data

D Device -» Log

” Device -» Runtime adjustments
Device -» Cylinder individual

offsets

Device -» Self test

78

Function

Prints the current configuration.

Prints the configuration to a PDF file.

Opens a print preview of the configuration.
Exits the MICT.

Connects to the device.

Cuts the connection to the device.

Downloads configuration data from the
computer to the device. Refer to Working with
Configurations on page 87.

Uploads configuration data from the device to
the computer. Refer to Working with
Configurations on page 87.

Opens the window Runtime Data. Refer to the
section Runtime Data on page 118.

Opens the window Log (Advanced Service
only). Refer to the section Log on page 146.

Opens the window Runtime Adjustments
(Service and Advanced Service only). Please
refer to the section Runtime Adjustments on
page 147.

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the
chapter Cylinder Individual Offsets on

page 153.

Opens the window Self Test (Service and
Advanced Service only). For this refer to
section Self Test on page 81.
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Symbol

Rev. 01/2022

Menu

Device -» Pickup trace

Device-» Set spark plug operating
hours

Device -» Set engine operating
hours

Device -» Set date and time

Device -» Send command - Reset
misfire counters

Device -» Send command -»
Acknowledge operational error

(Keyboard shortcut: Strg+R)

Device -» Access Control

Device -» Temperature Extremes

Settings -> Language

Settings -> Online update settings

Settings-> Database settings

Settings -» Temperature scale

£ MOTORTECH

Function

Loads the automatically recorded pickup
signals from the device. Refer to the section
Pickup Trace on page 83.

Opens the window Set spark plug operating
hours.

Opens the window Set Engine Operating
Hours.

Opens the window Set Date and Time, in which
you can set the clock in the device.

The misfire counters of all ignition controller
outputs are reset and restarted. Misfires that
previously occurred at the outputs are no
longer displayed.

All operational errors are acknowledged. This
can only be implemented while the engine is
not running.

The setup for the access control to the MICs is
described in a separate section. Please read
the section Access Control for MIC5 on

page 8s.

Opens the window Temperature Extremes in
which the minimum and maximum
temperatures of the controller and output
boards are displayed.

Opens the window Select Language in which
you can change the interface language of the
MICT.

Opens the window Online Update Settings.
Refer to the section Online Update Settings on
page 8o.

Opens the window Database Settings in which
various databases can be assigned as source
for the MICT.

Opens the window Select Temperature Scale,
in which you can change the unit for the
temperatures shown in the MICT.
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Symbol Menu Function

Settings -> Display by cylinders Not currently used.

Document -> Schedule Curve Opens the window Schedule. Please refer to
the chapter Schedule Curve on page 154.
Tools -» Coils Opens a database with information on
MOTORTECH ignition coils.
Help -»> Help Opens the online help function.
Help -> About MICT Opens detailed information on the MICT.

8.6 Online Update Settings

Perform regular online updates

MOTORTECH is constantly expanding its databases. Perform regular online
updates to make optimal use of the opportunities that the MICs provides.

The MICT uses data from an engine database and a coil database for the configuration. Such
data can be updated with automatic online updates. The settings for the update can be entered
with the following entry in the menu bar:

Settings -> Online update settings

& Online Update Settings b4

Enable automatic database updates
[[] use a proxy to access the web
http-Proxy:

Port: 80 =

Showlog | | Update Now [k ]| concm

You have the following options:

— Enable automatic database updates
Using the check box, you can enable and disable automatic online updates. As the default
setting, the online update is activated and is executed daily (if an internet connection is
established) at first start-up of the MICT.

— Useaproxy to access the web
Use the checkbox to activate settings for internet access via a proxy server, which you can
then set up by entering http-Proxy and Port.
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- Show Log
With this button, you can open a window in which the online updates performed are logged.

- Update Now
With this button, you manually start an online update.

8.7 Self Test

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs. As of firmware version 1.11.00000,
the ongoing self-test is indicated on the device by the status LED flashing once (1 orange 250 ms
on, 750 ms off). Refer to the section LED Functions on page 31.

Proceed in the MICT as follows:

Device -» Self test

MY Self Test - [m] x

WARNING

/1 In using the self test feature itis citical that the fuel to the engine
N3 has been shut off and the engine purged of any fuel gas. Failure to
do this could result in damage to equipment and nearby personnel!

Status Cydles Cydle Time - All Configured Outputs
© Unimited ® periog 500000 2] #s
Loded O 1% O Frequency 2,000 2] Hz
Active Outputs Control
® al

Ready

Olar ~ 44 B P st B8 stop

D COM4 1D MICS 5%2.20 {1.9.1 [0000ca01])

The following information is provided:

Status
The status displays indicate whether the ignition controller is ready for the self test.

— Locked
The ignition controller is in a state in which no self test can be done. For example, there is an
error or a configuration is currently being downloaded into the device.
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- Active
The self test is running.

- Ready
The ignition controller is ready and the self test can be started.

You have the following options:

- Cycles
Determine whether the self test should run unlimited or be terminated after a defined
number of cycles.

— Outputs
Define whether all outputs or only a defined output should be fired during the self test.

- Cycle Time - All Configured Outputs
Specify the cycle time either as a period or frequency. The value entered always refers to a
complete cycle. That means that all outputs that are configured are fires once per cycle. If
you only set one output for the self test, this would still only fire once per cycle.

- Control
Start or stop a self test using the corresponding buttons.
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8.8 Pickup Trace
The traces of the pickup signals support you in checking the behavior of the used pickup and
thus, for example, to detect and analyze irregularities or failures.

Pickup signals are automatically recorded by the ignition controller as soon as they are detected
at the configured inputs. Ten further signals are recorded if an error occurs during operation
(cumulative across all inputs). The recording is then stopped so that the pickup signals just
before the error can be analyzed. The records can be downloaded from the device at any time.

Proceed in the MICT as follows:

Device -» Pickup trace

Pickup trace
Example of a pickup trace for a configuration with three pickups:
—  Pickup input 1 (cam):
EXAMPLE Single event from the camshaft
—  Pickup input 2 (reset):
Single event from the crankshaft
- Pickup input 3 (triggen):
Trigger disc of type N with 160 events from the crankshaft

¥4 MICT - Pickup Trace - [m] x
File
Pickup Trace
1 —
43 i
o
5
P TR O I
=
~
pC:
u.l‘HHHIHIIHIHHII\II\\I\III\H\I\\ Il I |
R T T T o
0 2.000 4.000 6.000 8.000 10.000
Time [ms]

Operation
The following options are available via the menu in the window:

- Open
Opens a previously saved pickup trace.

- Saveas
Saves a pickup trace as a .putrace file.

— Close
Closes the pickup trace.
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There are the following options for the display of the pickup signals:

Zoom In/Out

Using the mouse scroll wheel you can zoom in and out of the displayed record range.
Alternatively you can also use the plus and minus keys on the keyboard. With the zoom
function, you can e.g. analyze the trigger signal more precisely (pickup input 3 in the
drawing).

B MICT - Pickup Trace - [m] x
File
Pickup Trace
43 LR
o
5
a2 | |
=
>
]
[t I
T T T T T T e e T A T T e s S S S
4.620 4.640 4.660 4.680 4.700 4.720 4.740
Time [ms]

Move displayed range
With the right mouse button pressed you can move the displayed range along the time axis.

Measuring

You can measure distances and the number of events in the displayed range by holding
down the left mouse button to highlight a section. You can find the following information in
the window:

— Position on the time axis
- Time difference (A) between the two selected points

— Number of events counted in the selected period

B MICT - Pickup Trace - [m] ble

Eile

Pickup Trace

Input 2 (positive): 22 eventd, min. period: 79.637 ms, max, period: 114.677 ms

HERNEEHE NN |E| I e 0 1

g3

o H 5792.391m3s

5 H A = 1947.019 ms

p | T R

g i Input 1 (positive): 11 eventd, min. period: 153.276 ms, max. period: 213,162 ms
=

o

A

A o o N s e s oy o s s s S s s S
2.000 3.000 4.000 5.000 6.000 7.000 8.000
Time [ms]

Error Analysis
The pickup traces support you, for example, in analyzing the following errors:

84

Configuration of the pickup does not agree with the wiring (e.g. trigger disc configuration,
allocation of the inputs, allocation of the shafts). In this case, you should compare the
values configured with the signals recorded (see Engine — Pickups on page 100).

One or more pickups have failed.
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Pickup trace

The pickup signals are only recorded on the inputs that are configured in
the MICT. If the configuration of the pickup inputs is not valid (e.g. three
signals from the same shaft), no signals are recorded.

8.9 Access Control for MICsg
If the access control to the MICs is activated, access to the following areas is possible with a PIN
only:

- Runtime Adjustment (Reset, timing, energy, secondary voltage estimation calibration and
secondary short calibration)

- Commands (Alarms, error commands, set engine/spark plug operating hours, and self test).
- Configuration (Transferring a configuration to the MICs)
The access control regulates the accesses to the device via the MICT. For explanations

concerning access control of the MICs5 and the delimitation of the access levels in the MICT, refer
to section Access Control on page 72.

The access control functions can be accessed in the menu bar via:

Device -» Access Control

8.9.1 Enable/Disable Access Control

® Enable/Disable access control
As a default setting, the access control is not activated, and all PINs are set
to 0000. Once the access control has been activated, and the PINs were

changed, these PINs will continue to be used. To activate the access control
again, you will need the PIN for level 3 (Master). It is therefore
recommended to reset all PINs before disabling.

NOTICE

If that was not done, or a system must be unlocked for another reason, a
request key can be issued in the MICT. Refer to the section Reset all PINs on
page 86.

To enable or disable the access control, proceed as follows:

1. Open theinput dialog via Device -» Access Control -> Enable or Disable access control.
2. Enterthe PIN for the level Master (Level 3).

3. Confirm the input with OK.
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8.9.2 Login/Logout

If the access control is activated, you are prompted to log in if you want to execute functions that
are allocated to a specific operating level. In addition, you can log in specifically to an operating
level via the menu bar.

To log into a specific operating level, proceed as follows:
1. Open the input dialog via Device-> Access Control -»> Login.
2. First select the level you wish to log on to.
3. Enterthe PIN for the desired level.
4. Confirm the input with OK.
> You are now logged into the corresponding level and can execute all functions that are
allocated to this operating level without having to log in again.
After completing the log-in, you can log out again as follows:

Device -5 Access Control -> Logout

8.9.3 Changing the PIN

To change the PIN for a specific operating level, proceed as follows:
1. Open the input dialog via Device -» Access Control -> Change PIN.
2. First select the level for which you wish to change the PIN.

3. Enterthe current PIN for the desired level.

4. Enter the new PIN in the two subsequent fields.

5. Confirm the input with OK.

> The PIN for this operating level has now been changed.

8.9.4 Reset all PINs

To reset all PINs, proceed as follows:
1. Open the input dialog via Device -» Access Control -> Reset all PINs.

2. Ifyou are not yet logged into the Master (level 3) level, you will be prompted to log in with
the relevant PIN.

3. Confirm the input with OK.
4. Toresetall PINs, you will be prompted again to enter the PIN for the level Master (Level 3).
5. Confirm the input with OK.

> AllPINs are now reset to the value oooo.
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To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in
case of emergency that was locked in this way, you have the following option:

1.

In the menu bar, select the entry Device -»> Access Control -> Get reset all PINs request key to
open a window with the same name.

Send the request key with the serial number to your service contact person at MOTORTECH
(refer to Customer Service Information on page 169). This key is valid only for the respective
controller and only for a certain amount of time.

> Your information will be verified, and you will receive an authorization key from your
contact person.

From the menu bar, select the entry Device -» Access Control -» Set reset all PINs
authorization key to open a window with this name.

Enter the authorization key received in the input field.
Confirm the input with OK.

» Ifthe input was correct, all PINs are reset to the default value oooo.

8.10 Working with Configurations

To ensure that the MICs correctly interprets incoming data and correctly controls the ignition
system, it requires information about the engine and the ignition system. This information is
stored in the MICs as configuration data.

You can use the MICT to perform the following for these configurations:

Create

Open

Edit

Save as a file
Download to the MICs
Upload from the MICs
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8.10.1 Create, Open, Save
b Click on the symbol to create a new configuration and select the corresponding
W device type. The device type corresponds to the first five digits of the
- arrangement number, which you can find on a label on your device.

&Y Select Device Type X

Sedect the device type you want to configure:
~ Ignition Controllers ~
> MIC100
> MIC3
> MIC3+
> MIC4
v MICS
MICS 5¢1.08 SE (2 outputs) ] P/N 12.34.567-¢ ‘
MICS 5x2.20 (20 outputs)
» MICG
. iceso ]NN 5x2, 20, XXXX-XXHK-XX-X ‘
~ Stepper Motor Cards ]
Varictep
VariStep3
v Emission Controllers
VariSCR Standard S

E
Q
al
Il

£ MOTORTECH"

www.motortech.de

S/N 01008066 |

o o

Click on the symbol to open a saved configuration.

& Open Configuration File *

L L < 05 (.. » MICT-Kenfig... >~ O MICT-Konfigurationen” dur

Organisieren = Neuer Ordner - m @
Name Anderungsdatum Typ Grofe

Enginel.mic5 10.06.2021 08:26 MICS-Datei 13K8
g

[ Engine2.mics MIC5-Datei 13KB)
| ] Engine3.mic5 MICS-Datei 13K8|

Dateiname: [Enginel.mics | [MICS Configuration Files (".mic ~

Click on the symbol to save the configuration currently displayed in the MICT to
E a storage device.
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NOTICE

1

Compatibility of the configuration files

Configuration files are only compatible for the respective device type, even
if the file extension is identical. For example, files created for a MIC3 cannot
be downloaded to a MIC3+ and vice versa.

To use a configuration for another device, the series and the first four digits
of the arrangement number must match. This information can be found in
the title bar of the configuration and on the respective device:

MIC3 MIC3+
B unnamzd.ml:} MICT M unnamzd.ml:}@\(]o 3119 MICT
File Device Settings Document Tools Help File Device Settings Document Tools Help

ARSI DAL HS B

Paramaters
Engine Selection

Paramaters

Configuration Page
Engine Selection

Configuration Page

~ Engine

OTORTECH'

|@N 3x1.12)xxx—xxxx-xx—x |

I l

~ Engine

|
j

MOTORTECH"

(NN 3x1.1 2 KXRX-XKKK-XX-X |

I l

If, for example, a system is to be changed from a MIC3 to a MIC3+, the
configuration of the MIC3 can be saved as a PDF file. Then a new
configuration file must be created for the MIC3+ and the values from the
PDF file must be entered. Alternatively, the MICT can be opened twice and
the values transferred to a newly created configuration file.

www.molortech de
www.molortech de

8.10.2 Upload, Download

S

53%

Rev. 01/2022

Click the symbol to upload the current configuration from the MICs to the MICT.
If applicable, the MICT first establishes a connection to the MICs connected.

Click on the symbol to download the configuration set in the MICT to the MICs.
This function can only be executed while the ignition is not active. This action
overwrites the existing configuration on the device. If applicable, the MICT first
establishes a connection to the MICs connected.

£ MOTORTECH
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Existing configuration is cleared!

If you download a configuration to a MICs, the previous configuration is
deleted and the new settings are immediately implemented.

Runtime adjustments

If you change a configuration stored in the MICs via runtime adjustments,
the configuration must be re-uploaded from the device so that the changes
are displayed in the MICT's configuration views.

8.10.3 Compatibility Information

M Information x

Some optional configuration values could ot be uploaded from the device. Assuming default values. (i)

T

If you upload a configuration from the MICs to the MICT that does not correspond to the status of
your MICT, or if you open this type of configuration in the MICT, the following situations may
occur:

— Novalues are present in the configuration for certain MICT functions. The MICT assumes the
standard values for these functions.

— The configuration contains function values that are not support by the MICT.
The following situations can occur if you download a configuration from the MICT to a MICsg
whose firmware does not correspond to the status of your MICT:

— Novalues are present in the configuration for certain firmware functions. The firmware
continues to use the preset values for these functions.

— The configuration contains function values that are not support by the firmware.
If you download a configuration into the MIC5 and are notified of functions that are not

supported by the MICT, you should check the MIC5 settings. Re-upload the configuration from
the MICs to the MICT. You can then see which settings are not transmitted to the MICT.

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the
MICs functions without restriction.
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8.11 Configuration
The window opens after you select the device type for a new configuration or an existing
configuration or have uploaded one from the ignition controller. You can make changes to the
configuration by selecting an entry from the navigation bar. The corresponding configuration
data are then displayed in the configuration section and can be processed. The following
sections will describe the settings and adjustments you can implement in the different areas.

Rev. 01/2022

Indication of invalid entries
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An invalid selection or invalid input values are highlighted by pulsating

warning signs on the configuration pages of the MICT. Additional

information is provided in the status bar.

Example:
Configuration Page
v Engine
Parameters
I71 Ignition Outputs
| Ignition Cails
| Speed Settings
~ [ Pickups
| General
| Inputs
~ Timing
| Analog Inputs
~ (7 Schedule A
| General
1 Energy
v Miscellaneous
| Communication
1 Information

Igniton Outputs
Output Bank A

Number of Outputs: |8

@ | [N [o] (o] [&][w] (N [m

Output

Angle [
~|[o0 ‘fi_f;\‘
- }D.D ! m \!
v [oo Iy
v [oo I
~||oo A
~||oo ey

\

v oo \‘ A ‘[
- o0 A,

(

fing Angle: 0.0 - 720.0, Default = 0.0, min. distance limited by overspeed (invalid due to cgbt ) COMn/a IDn/a ADV. SERVICE n/a
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8.11.1 Engine — Parameters

M unnamed.mics” (MICS 5x2.20) - MICT = a X

File Device Settings Document Tools Help

A HES i S9sEa

Configuration Page Rt
v [Engine Engine Selection Engine Information
D Parameters Engine Manufacturer Series Type Ng&m&mﬁlxﬂmj Selected Engine Summary
1 Cylinder Names -
S ATAX E 08 Series E 2842 E302 MAN - E 2842 LE332
| Ignition Qutputs Bergen Disssl E 26 Series £ 2042 E312
"1 Ignition Cails Caterpillar E 28 Series E 2842 LE202 ::gmwmh.eummer&
" Pickups Clark E 32 Series E 2842 LE302
v Timing Cooper Bessemer E 2842 LE312 ;‘gﬂﬂmlﬁ
= ™ E 2842 LE322 "
| Analog Inputs 50.0
<y Guascoxr E 2842 LE332 120.0
R E S:'“d““" Ingerscll Rand £ 2848 LE322 210.0
| Genesal Jenbacher E 2876 E302 foryd
7 Energy Lietherr E 2076 E312 00
~ 9] Schedule B MRH E 2876 LE202 :SS(DLg
Y General Nordberg E 2876 LE212 Py
- Genera Ruston E 2876 LE30Z 000
| Energy Sequence E 2876 TE302 690.0
| Miscellanecus Superior 0.0
~ [Inputs/Outputs Waukesha
] Alarms
1 As01
7 Inputs
v Miscellzneous
| Communication
'f Information
MOTORTECH does not assume liability for the information in the engine database. Please contact MOTORTECH if
T discrepancies are found.
1f your engine is not available in the list contact MOTORTECH service please.

& COM4 ID MICS 5:2.20 (1.91 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

Engine Selection
The MICT holds an engine database with data from various manufacturers and model series.
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields.
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Wiring in firing order is assumed as standard. If straight order wiring is supported for the
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output
configuration.

¥ Wiring ? b4

Please select the type of wiring you are using.

In case of custom wiring please select wiring in firing order and adjust the output
configuration afterwards.

() wired in firing order
@ wired in straight order {user defined orientation)

Coil 1 71(e] (@]t
a||o ol|z
9| O (o] I ]
10 (o] (o] 4
1 (o] (o] 5
12 (o] (o] 6 Col 1
Cyl. 58 (CILL LD Cyl. 14
Cyl. 7-12 Fiywheel oyl 16
change orientation of rail change hamass change orientation of ral

You can use straight order wiring, if:

- Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the
wiring rail is marked in the view Wiring.

- Wiring of the ignition controller is done corresponding to the instructions in section Straight
Order Wiring of the Ignition Outputs on page 60 (for example with an open wiring harness or
via a junction box).

The configuration of the ignition outputs is automatically adapted corresponding to your
selection. If you want to use a different wiring, these settings must be adapted appropriately.

If the pertinent engine is not available in the database, settings can also be entered by selecting
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine
Manufacturer and select the firing stroke in the column Series, then the number of cylinders,
and the ignition offset of the engine as needed. After making your selections, the right hand
section Engine Information will display a summary of the parameters selected.

The summarized data are transferred to the subsequent configuration page Ignition Outputs.
The values displayed there can only be changed by users with authorization to access the
Advanced Service level.
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i Engine database

MOTORTECH does not assume liability for the information in the engine
database. Please contact MOTORTECH if discrepancies are found.

NOTICE

New Engine Configuration

Staff with the authorization for the Advanced Service level additionally has the option for
entering the engine data manually, i.e., without selecting entries from the engine database. For
this purpose, click on the New Engine Configuration button and select the engine type, number
of cycles, and number of cylinders in the dialog box opening up. Additional information can be
entered on the configuration page Ignition Outputs.

& Mew Engine Configuration X
Engine Type: V engine v
Strokes: 4-stroke =
Number of Cylinders: 12 b

l Note: Spedify Firing Order and Firing Angles on the Ignition Outputs Page!

o ][ conee
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8.11.2 Engine — Cylinder Names

¥ unnamed.mic5” (MIC5 5x2.20) - MICT = [m] X

File Device Settings Document Jools Help

AHF5S %% @0

Configuration Page Cincac Nanag
v [ [4) Enable Cylinder Names
| Parameters
GRS Bank Name: |B Bank Name: |A
| Ignition Qutputs
Ignition Coils O @ S 6 6 : O
| Pickups
¥ Timing D ] O] O] |[2 e
| Analog Inputs
v [ Schedule A 9 O 1©] Iz
| General [10—] o] lo [4—]
Energy
~ 7 ScheduleB 1 Ol 9] |ls
General [—l [—]
Energy 2 2 2 &
Miscellanecus [CIT_10T
~ Inputs/Outputs Flywheel
Alarms
ASO1
Inputs
~ Miscellaneous
Communication
Information
[[] Show banks in reverse order

) COM4 1D MICS 5x2.20 (1.91[0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you
can individually name each cylinder. The schematic representation of the plan view of the
selected engine supports you in this. Enter the following settings:

— Enable Cylinder Names
Activate the checkbox in order to assign cylinder names. In order to use this function, the
number of cylinders must be defined. Establish the number of cylinders either by using a
configuration from the engine database or by creating a new engine configuration via the
corresponding button. Refer to the section Engine — Parameters on page 92. If you have
activated the checkbox, the assigned cylinder names must also be assigned to the
corresponding ignition outputs, before the configuration is transferred to the ignition
controller. Otherwise there will be an error message. Refer to the section Engine — Ignition
Outputs on page 96.

- Bank Name
Enter a name for the respective cylinder bank.

— Cylinder Names
Enter a name for the respective cylinder.
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o
- o3
currently not used

— Show banks in reverse order
currently not used

8.11.3 Engine — Ignition Outputs

M unnamed.mics” (MICS 5x2.20) - MICT - o X
File

Device Settings Document Tools Help

S AHFRS %R E0

Configuration Page K ony Ouiputs:
“ [Engine Output Bark A Output Bark B
7 Paremeters
. Number of Outputs: & - Number of Outputs: |6 -
Cylinder Names
'j JouicolCpts Cylinder Output Angle [%] Angle [%] utput Cyinder
Ignition Coils
S L e o0 ] [as00 ][ ~ [z -
Pickups
~ Timing 2 ~[s ~ [480.0 ] [2w0 ][z ~[s -
1 Analog Inputs 3 ~[s | [200 ] [s900 1ls -9 -
v [ Schedule A
. 1 ~|[s ~ | [s00.0 ] [s300 [z * [ -
General
) ey 5 v |2 ~ [1200 | [smo 1[s +[u -
v [T Schedule B 5 - la v [360.0 ] [s00 1[x [ -
] General notassigned ¥ |7 7| |00 0.0 7 ~ | |notassigned
Energy notassigned  * |8 ¥ 0.0 0.0 8 ¥ | |notassigned ¥
| Miscellaneous
~ Inputs/Outputs notassigned ¥ |9 7| 0.0 0.0 9 - | |notassigned ~
| Alarms notassigned ¥ |10 7| 0.0 0.0 10 ~ | |notassigned  ~
] AsO1
| Inputs
v Miscellanecus
| Communication
" Information

) COM4 1D MICS 5:x2.20 (1.9.1 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

Make adjustments to the following settings as needed:

— Number of Outputs
Select the number of outputs for the respective output board.

- Column: Cylinder
Select a cylinder. The displayed names are specified on the configuration page Engine —
Cylinder Names.

— Column: Output
Select the number of the respective output.

— Column: Angle
Enter the firing angle for each output.
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Default Application

If you select from the engine database, the data stored for the selected configuration are
displayed. These data can only be changed by personnel with access to the Advanced Service
level.

New Engine Configuration

If you have created a new engine configuration on the configuration page Engine — Parameters
using the corresponding button, first the number of outputs corresponding to the number of
cylinders are distributed to the output bank A and output bank B. Selecting the number of
outputs enables access to the fields for the configuration of the outputs. We recommend that
you distribute the number of outputs evenly among the output banks and allocate the larger
number to the A output bank if the number is uneven.

By default, the ignition outputs are distributed so that cylinder 1 of the firing order is always
allocated to output bank A with a firing angle of 0°. The further distribution is implemented by
alternating between output bank A and B. The firing angle for each output results from the
addition of the firing interval to the respective previous output.

Operational safety!

Never connect more than one output to each ignition coil, as the output
boards can otherwise be damaged.

The allocation of outputs on the output banks to contacts of the output connector of the device
and the cylinders is determined by the wiring. The user must take the wiring into account during
the configuration; it cannot be checked by the software.

Interval between two ignitions

The interval between two ignitions on one output bank must be at least
2.8 ms. During the check, the configured overspeed is used in the
calculation.
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8.11.4 Engine - Ignition Coils

™! unnamed.mic5® (MIC5 5x2.20) - MICT = a X

File Device Settings Document Tools Help

AHSF S 8 %Rt Ea

Configuration Page Tgutcacots
v [Engine Ignition Coll Type:
| Parameters Coll Type: |06.50. 104 hd [ secondary Diagnostics Enabled
| Cylinder Names
S Secondary Voltage Estmation Calibration
Ignition Outputs .
1 Ignition Cails Output Offset Output Offeet
| Pickups Al 0.0 = Bl ﬁ
v Timing I =
| Analog Inputs A2 0.2 C B2 0.0 O
v 1 Schedule A A3 0.0 : B3 1.0 =
1 Genesal A4 0.0 = B4 0.5 :
| Energy 45 04 & 85 0.0 <
~ [}l ScheduleB < =
y AB 0.0 = B& 0.0 =
General
| Energy A7 0.0 5 B7 0.0 =
| Miscellaneous a3 0.0 z B8 0.0 -
 Inputs/nputs a9 0.0 2 ) 0.0 E
| Alarms
| Aso1 A1D 0.0 2 B10 0.0 &
| Inputs
v Secondary Shart Datection Calbration
] Communication Secondary Short Enable Voltage: [0.420 2] kv
Information Secondary Short Sensitivity: [0.9996 [

@ COM4 ID MICS 5:2.20 (1.91 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

Ignition Coil Type
Select the ignition coil type from the drop-down list. (Without this selection the configuration
cannot be downloaded to the MICs.)

® Only use measured ignition coils

To operate the MICs, only ignition coil types measured by MOTORTECH may

be used. Allignition coils used must correspond to the part number
selected in the drop-down list. Different coil types must not be mixed and
also no equivalent or replacement types may be used.

If a coil type used is not in the drop-down list, then the MICs is currently not
used.
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Secondary Diagnostics Enabled

The secondary diagnosis can be deactivated and activated for ignition coils that support this
function. If the ignition coil does not support this function, the secondary voltage estimation
calibration and the of the secondary short calibration are not available.

Secondary Voltage Estimation Calibration

A correction value without units can be set for the secondary voltage estimation for every
configured output to increase the accuracy of the secondary voltage estimation for each
individual cylinder. This allows, for instance, different cable lengths on the engine to be
compensated.

The values of the secondary voltage estimation can be changed for each individual cylinder. The
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You
can adjust the secondary voltage estimation while the engine is running in the runtime
adjustments (refer to Runtime Adjustments — Secondary Voltage Calibration on page 151).

Secondary Short Detection Calibration

The starting voltage and the secondary short detection sensitivity can be adjusted. You can
adjust the secondary short detection in the runtime adjustments while the engine is running
(refer to Runtime Adjustments — Secondary Short Calibration on page 152).

Secondary Short Enable Voltage
Set the average ignition voltage required to activate the secondary short-circuit monitoring:
- The secondary short detection is always activated at a value of o kV.

- The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.

- The sensitivity is low at a value of 1.02.
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8.11.5 Engine — Pickups

File Device Settings Document

HaHES5S %% @0

Configuration Page
~ Engine
| Parameters
1 Cylinder Names
| Ignition Outputs
| Ignition Coils
:] Pickups
v Timing
B Analog Inputs
~ [ Schedule A
7 General
" Energy
~ [ Schedule B
7 Genesal
| Energy
7 Miscellaneous
~ Inputs/Outputs
71 Alarms
1 AsO1
77 Inputs
¥ Miscellanecus
1 Communication

1 Information

™! unnamed.mic5® (MIC5 5x2.20) - MICT = a X

Tools  Help

Pickups
Pickup Setup Information

3PU (N events (passive) and 1 reset event (passive) from crankshaft and 1 event (active high) from
camshaft)

Input 1 (Cam} trigger disc type SINGLE EVENT and active high pick up on camshaft
Input 2 (Reseth trigger disc type SINGLE EVENT and passive pick up on crankshaft
Input 3 (Trigger): trigger disc type N with 150 events and passive pick up on crankshaft
Pickup Setup

Predefined Setup: |3PU - User-defined

PP— ooe =] [ Agget

Pickup Sensitivity: | medium -

Trigger Humber of Triggers:

Aux Pickup Supply Voltage
‘Aux Pickup Supply Voltage: v & 2:15;1 !r;:;:;:.mm voltage setting

Speed Settings
Ignition Release: h
Security Speed: [ﬁ
Nominal Speed: | 1500
Qverspeed: | 2000

Max, Power-On Speed: |6000

@ COM4 ID MICS 5:2.20 (1.91 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

® Active pickups

Check when using active pickups that the auxiliary supply voltage is
configured for your application.

Pickup Setup Information

The settings made in the section Pickup Setup were summarized once again in the section
Pickup Setup Information.
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S MOTORTECH

Pickup Setup
Enter the following settings in this section:

Predefined Setup
Select the pickup configuration suitable for your application from the list. The
configurations available for selection depend on the previously entered settings.

Index/Reset Position

Enter the distance between the first event after the set index/ reset marking and top dead
center. With the button Adjust, you can enter the measured firing angle for a given nominal
value. The system calculates the difference from these values, which is added to or
subtracted from the index/reset position.

Pickup Sensitivity

Open the pick list and select the desired sensitivity level for the pickup. This setting
overwrites the value of the pre-trigger voltage if the latter was defined in the user-defined
pickup setup.

- High
The signal processing starts at low engine speeds. This setting can result in increased
susceptibility to failure.

—  Medium
Default setting for MICT. This is a trade-off between start-up speed and sensitivity.

- lLow
The signal processing does not start until high engine speeds are reached. This setting
can result in reduced susceptibility to failure.

Trigger/Cam No. of Triggers
Enter the number of events. The input Cam or Trigger is automatically selected by the MICT
and is governed by the selection of the pre-defined pickup settings.

User-defined
Staff authorized to access the Advanced Service level can, in addition to the standard
settings access, use a manual setup option by clicking on the button User-defined.

¥4 Pickup Setup %

Pickup Inputs

Input Type humber of Events Speed Active/Passive  Pre-Triggar [V]
Pickup Input 1 (Cam) | SINGLE EVENT AdiL] CAMSHAFT ¥ | activehigh ¥ | (2.5 3
Pickup Input 2 (Resetk | SINGLE EVENT AdiL] CRANKSHAFT ¥ | passve ¥ |[15 3
Pickup Input 3 (Triggerk |M > CRANKSHAFT ¥ | passve ¥ | |15 *

Cancel
Tigger Disc Type, Default = NONE
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102

Type

You can select the type of events that will occur on this input for each pickup input. Type
and number of events are defined by the discs or ring gears used. If you decide not to
use a pickup input, select the entry None from the list. You can set the following types:
N

Disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a
ring gear with 160 teeth (N=160).

N+1

Disc type N with one additional event, e.g. a disc with 12 teeth and one additional tooth
for the index signal (N=12).

N+1 extended index range

Disc type N with an additional event, e.g. with one disc with 12 teeth and one additional
tooth for the index signal (N=12). The permitted range for the index signal is expanded
to 75 % of the tooth period. An incorrect direction of rotation of the engine cannot be
detected by this setting.

N-1

Disc type N, where one event is missing, e.g. a ring gear with 160 teeth on which one
tooth was removed (N=160). This missing event is used to determine the index signal
N-2

Disc type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on
which two teeth located next to each other were removed (N=60). This missing event is
used to determine the index signal.

N Magnets, Single Magnet

You will always use these two types together for a disc with magnets having opposite
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal
distances on the disc, has a reverse polarity. Thus, the disc supplies two signals that
can be analyzed by a pickup.

Single Event

Disc that supplies a single event, e.g., a disc with one tooth or one magnet.

Number of Events

Enter the number of events that occur on the pickup if more than one event is expected.
For the types N+1 and N-1, enter the value for N and not the total number of events. With
the type N Magnets, the number of magnets with identical polarity must be entered.
The number of events must lie between 3 and 500. Additionally, it must be taken into
account that the sum of the frequencies at the pickup input does not exceed the limit of
10 kHz at the pre-set overspeed.

Speed
Select whether the respective pickup will pick up the signal off the camshaft or the
crankshaft.
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- Active/Passive
Select the pickup to be used from the pre-defined pick list:
Passive
passive pickup
Active (low)
active pickup with high level as quiescent level
Active (high)
active pickup with low level as quiescent level

- Pre-Trigger
Enter a value between 0.1V and 7.5 V for each pickup to set the pickup sensitivity level.
Signals that fall short of the set voltage will not be analyzed. A low pre-set value
therefore results in a high sensitivity level, a high value results in a low sensitivity level.

® Pickup setup information
The respective latest setting in the area of the pre-defined or arbitrary
pickup settings is transferred to and displayed under Pickup Setup
—_— Information.
NOTICE

Aux. Pickup Supply Voltage
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and
24 Vis possible.

Speed Settings
Enter the following settings in this section:

Ignition Release
Enter the release speed for the ignition at which the first ignition is to fire. The value shall
not exceed 1/7 of the nominal speed.

Security Speed

Enter the security speed. Below the value entered, the ignition can be switched on and off as
desired. If the ignition is deactivated during operation above the set speed, the ignition
cannot be immediately reactivated. Only when the ignition no longer reads a speed, i.e., the
engine has come to a standstill, can the ignition be reactivated.

Nominal Speed
Enter the nominal speed at which your engine is to be operated. With engines that are to be
operated with variable speeds, the max. speed of the operating range must be entered.

Overspeed

Enter the speed at which the ignition is to be shut off as overspeed protection. With engines
that are to be operated with variable speeds, a speed above the operating range must be
entered.
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- Max. Power-on Speed
Enter the maximum permitted start speed at which the MICs starts sending ignition pulses.
Avalue of 6000 rpm is set as the default value: The MIC5 can be activated at the starter
speed and immediately send ignition pulses.
For a value of o rpm the MICs can only start sending ignition pulses once it has registered
that the engine is at a standstill.

8.11.6 Timing — Analog Inputs

™! unnamed.mic5® (MIC5 5x2.20) - MICT

File Device Settings Document Tools Help

aHFES A %N% E0

Configuration Page Analog Inputs Base Settings
~ Engine Analog Current Input
| Parameters Lower Limit: |4.0 +| mA
1 Cylinder Nemes - ETR
| Ignition Qutputs -
y - . Failure Threshold: |3.2 | mA
Ignition Coils
| Pickups Analog Valtage Input
- =
'ﬂmm? Lower Limit: |0.0 5 v
|| Analog Inputs
~ ) Schedule A Upper Limit: v
| General Failure Threshold: v
1 Eneroy Aux Analog Tnput Supply Vol
i n
v [ Schedule 8 EUESE Mo
A General Aux Analog Input Supply Voltage: v

) Enengy Please ensure the correct voltage
| Miscellaneous B\, setting for your application.
~ Inputs/Qutputs
7 Alarms
1 ASO1
7 Inputs
v Miscellaneous
" Communication

1 Information

@ COM4 ID MICS 5:2.20 (1.91 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

® Auxiliary supply voltage

Check with the configuration of the analog inputs, that the set auxiliary
supply voltage corresponds to your application.
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Analog Inputs Base Settings
The ignition timing adjustment can be made using two analog input signals, which can be set
within the following limits:

— Analog current signal: 0-20 mA

- Analogvoltage signal: 0-10 V

Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also,
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is
classified by the ignition controller as failure (e.g. wire break). The error value configured in the
schedule was set for the affected input. To reset the error state, a threshold will need to be
exceeded. This threshold value is calculated as follows:

Threshold to reset the error state = 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold

You set the analog input that will be used and which timing adjustment results from the analog
signal for the two possible schedules. Refer to the section Timing — Schedule A/B — General on
page 106.

Aux. Analog Input Supply Voltage

An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value
between 5V and 24 V.
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8.11.7 Timing — Schedule A/B - General

M unnamed.mic5™ (MICS 5x2.20) - MICT b m] X
File Device Settings Document Tools Help
AHS5S B %R%W@Ea
Configuration Page Schedule A General Settings
v Engina_ [ Enable Schedule Description: |Biogas
Parameters
1 Cylinder Nemes Limits Cylinder Individual Timing Limits
| Ignition Outputs Min/Max Timing Point 1: | 35,0 BTDC - Min/Max Individual Limit 1: | 2.0 ADV -
| Ignitien Coil:
gniten ot Min/Max Timing Point 2: |5.0 BDC v Min/Max Individual Limit 2: 2.0 RET -
Pickups
v Timing Base Timing [ speed Curve
Analeg Inputs
9Inp I || e o e S
~ [ schedule A
a8 General [ Patentiometer Function e e ere] e P
| E
v ) sch :E‘rgg Gockniacs L I 100 0.0 RET <
chedule
3 Generl ool Coche e | 2 o] RET <
) ey Elganeives . &
| Miscelancolis AtLower Limit (4.0mA): [ 1.0 ADv o + 0 0.0 BEE -
Vv Inputs/Qutputs —
Y Alsiss AtUpper Limit (20.0 mA): RET  ~ 5 RET 7
| ASO1 Defauit: RET < 6 RET 7
7 Inputs 7 RE -
~ Miscellaneous [] Analog Voltage Input . > -
— ), RE! s
Communication AtLower Limit (0.0V): [0.0 RET -
| Information —
At Upper Limit (5.0V): [5.0 | |rer -
Default: 0.0 RET
& COM4 ID MICS 5:2.20 (1.91 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

Schedule A General Settings

The MICs offers two schedules for implementing the necessary settings for the timing of the
engine. The schedules A and B can be used for dual fuel operation, for example. The system
switches between the schedules via the input Schedule A/B. If only one schedule is configured,
the switch is ignored. The configuration options for schedule B are identical to those for set A.

- Enable Schedule
The settings are enabled or disabled by checking/unchecking the box. One schedule must
always be activated.

— Description
Enter a description for the schedule (e.g. natural gas for the setting for this type of gas).

Limits
Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs

will be limited to this range relative to the respective top dead center of the pertinent cylinder.
The global timing can then not be shifted beyond this range by any adjustments.
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Base Timing
Enter the timing specified by the engine manufacturer. This point must be within the limits
entered and is a static portion of the global timing.

Potentiometer Function

The checkbox enables and disables the potentiometer function for manually adjusting the global
timing by the respective stops of the potentiometer set, depending on the direction of rotation. If
the potentiometer is subsequently disabled once again, the system will no longer access the
data during the following data transfer to the device and restart of the engine, and the device
will no longer use this data to calculate the global ignition timing.

Analog Current Input / Analog Voltage Input
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should
prefer the analog current input due to its lower sensitivity to faults.

Enter the values by which the adjustment is to be implemented for the corresponding input
signal. An error value can be entered for the signals if a failure threshold has been defined for
the corresponding input in the window Timing — Analog Inputs. If the signal is below the failure
threshold, the timing is offset by the error value. The adjustment remains until the signal again
exceeds the threshold to reset the error state (see Timing — Analog Inputs on page 104).

Cylinder Individual Timing Limits

Enter the maximum possible cylinder individual offset. This setting limits, among other things,
the adjustment possibility in the window Cylinder Individual Offset. In addition the limits also
apply to the corresponding adjustment signals from all other sources, for example via the field
buses.

Speed Curve

The speed curve can be activated and disabled by mouse click and offsets the timing depending
on the speed. A max. of eight speed points are available. If you select a number of points from
the list, the corresponding number of fields is activated for input.

The first speed point is always set to o RPM. All other timing points are assigned with the value
by which the signal is to be offset when the respective speed is reached. For the last speed
point, the timing of the nominal speed should be entered. Please note that the speed points
must always be entered in ascending order.
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8.11.8 Timing — Schedule A/B - Energy

™! unnamed.mic5® (MIC5 5x2.20) - MICT = a X

File Device Settings Document Tools Help

AEFHS A % Ea

Configuration Page

Schedule A Energy Settings

- B Start Phase
| Perameters Speed Linit: |600 RPM
7 Cylinder Nemes Tmetmt: [0 s
| Igeition Outputs Start phase ends i bott kmits are exceeded.
| Ignitien Coils
Pickups Spark Duration: | 300 3] s
v Timing Spark Intensity: |80 3} mA
Analog Inputs =
Max. Breakdown Voltage: |30 L
~ Schedule A
7| General Energy Limit: m
&1 Energy (imited by nominal speed)
¥, Schedule 8
sy Mormal Operation
General
e SparkDuratons [300 2] g
| Miscellaneous Spark Intensity: |70 2| mA
v Inputs/Qutputs
Pty St Max. Breakdonn Voltage: |20 =]
Alarms
] ASOt Energy Limit: | 500 | m
| Inputs

g
i e Secondary diagnostics available if max, breakdown voltage is setin range 38 KV to 47 kV. Additionally itis required that

" Communication the energy limit is set suffidently high.
Start phase: max. breakdown voltage out of range suitable for secondary diagnostics
Normal operation: max. breakdown voltage out of range suitable for secondary diagnostics

P
| Information \!/

/ Minimum required supply voltage for sustained operation:
/ U\ schedie &7 10.4V

& COM4 D MICS 5:2.20 (1.9.1 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

You can make different energy settings for the start phase and normal operation.

Start Phase

Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both. If
you enter values for both criteria, both values must also be exceeded, so that the ignition
controller classifies the start phase as ended and sets the values for normal operation. If you
only want to use one criterion, set the other value to o. If you do not want to define any start-up
phase, set both values to o.

Enter values specific to your application for the Spark Duration, the Spark Intensity and the
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum
voltage expected during operation.

Normal Operation

If the criteria specified for the start phase are exceeded, the settings for normal operation are
used by the ignition controller. Make the energy settings the same as for the start phase.
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Energy Limit

You can use the field Energy Limit to limit the output energy made available by the ignition
controller. If the set output energy is no longer sufficient to reach the set energy values (spark
duration, spark intensity, max. breakdown voltage), the spark duration is reduced

correspondingly.

8.11.9 Timing

Required supply voltage for energy control

Depending on the output configuration and the energy settings, for a
correct energy control, a higher supply voltage than the minimum 10 V DC
sufficient for operation of the device can be necessary. If this is the case,
the required supply voltage is displayed in a notice in the window Timing —
Schedule A/B - Energy.

— Miscellaneous

File Device Settings Do

Q= 5

M Unnamed.mics™ (MICS 5x2.20) - MICT - [l ®

cument Tools Help

e %W E0

Configuration Page
~ Engine
Parameters
| Cylinder Names
Ignition Qutputs
| Ignition Coils
Pickups
~ Timing
Analeg Inputs
v Schedule A
| General
Energy
hd Schedule B
General
Energy
[ Miscellaneous
v Inputs/Outputs
Alarms
AsSO1
Inputs
Vv Miscellanecus
Communication

Information

Miscellaneous
Max Firing Angle Change Per Cyde

Adv: |0.5
Ret: |0.5

) COM4 1D MIC55x2.20 (1.91 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

You can specify how fast the changes of the timing should be executed.
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- Maximum Firing Angle Change Per Cycle

Specify the maximum degrees per cycle that the ignition timing may be shifted by for both
directions, i.e. between two firings of a cylinder. If the specified ignition timing adjustment

is larger than the given value, it is divided among several cycles.

8.11.10 Inputs/Outputs — Alarms

B! unnamed.mics” (MICS 5%2.20) - MICT
File Device Settings Document Tools Help
' $HS B H SRS EO G
Qb 59 4 "a %y &
Configuration Page Alarms and GPO Settings
v Engine A
| Parameters 1: speed > threshold (Tip 1) Alarm 1
Y . . Function
Cylinder Names. 2 unused
| Ignition Outputs 3 unused DeScbon h”p_l
- . . 4: unused
Ignition Coils & unused Function: |speed > threshold
| Pickups 6: unused Thresheld: | 1000.0 RPM
~ Timing 7: unused
| Analog Inputs B: unused Hysteresis: RPM
v (5 Scheduie A & unused peaifo  ms
¥ 10: unused
General
11: unused Settings
Energy 12: unused
v () Schedule B 13: unused [ Engine Shutdown
General 14: unused (7] Permanent - Keep output activated unti alarm is acknowledged
S 15: unused =
Log Events
Energy 16: unused
Miscellaneous Srere
~ Inputs/Outputs
7] Alarms &4 epo1
] AsOt
Inputs
v Miscellaneous
Communication
" Information
GPO Sattings
GPOL: NORMALLYOPEN ~
@ COM4 ID MICS 5x2.20 (1.91[0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

The MICs ignition controllers include a total of 16 configurable alarms that can be allocated to

the general purpose outputs.

— Description

You can enter any desired description for an alarm. The description is used for logging the

alarms that have occurred in the event list in the MICT.

— Function
The alarms can be used depending on the following functions:

- Unused
- Speed above threshold / below threshold

- Engine operating hours above threshold / below threshold
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- Spark plug operating hours above threshold / below threshold

— Warning active

- Error active

- Temperature above threshold / below threshold

- Analog voltage input over threshold / under threshold

- Analog current input over threshold / under threshold

- Global ignition timing above the threshold / below the threshold

- Supply voltage above threshold / below threshold

- Min. spark duration above threshold / below threshold

- Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) above threshold

- Consecutive misfires (primary, single output) above threshold

- Misfire rate (secondary, individual output) above threshold

- Misfire rate (secondary, all outputs) above threshold

- Misfires per second (secondary, all outputs) above threshold

- Consecutive misfires (secondary, single output) over the limit
— Threshold

Input of desired threshold value.

— Hysteresis
Input of desired hysteresis value.

— Delay
Input of desired delay. The threshold value defined in the alarm must have been exceeded or
not reached for a longer period than the specified time for an alarm to be triggered. If a
corresponding value occurs for a shorter period of time, no alarm is triggered.

— Engine Shutdown
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered.
The shutdown causes an operational error. Therefore the checkbox should not be checked, if
the alarm Error active is selected.

- Permanent - Keep output activated until alarm is acknowledged
If this box is checked, the output remains permanently active until the alarm is
acknowledged. If the box is not checked, the output remains active only for as long as the
alarm is active.

- LogEvents
If this box is checked, the event list records when the alarm occurred or when it was
acknowledged.
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Outputs
Activate the checkbox GPO1, so that the general purpose output is activated when the alarm
is triggered.

GPO Settings
Configure the general purpose output as normally closed or normally open.

8.11.11 Inputs/Outputs — ASO1 (Auxiliary Synchronization Output)

™! unnamed.mic5® (MIC5 5x2.20) - MICT = a X

File Device Settings Document Tools Help

Configuration Page

~ Engine Number of Points: |1 = Angle Reference: |Actual Angles Depending on Global Timing ~

~ Timing

v Inputs/Qutputs ‘

¥ Miscellanecus

AHFHS R @0

ASO1

Parameters
| Cylinder Names Mode:| jiialloy kg Ege:(le(ath) ~

Ignition Outputs
| Ignitien Coils

Pickups

Point Angle [] Pulse Width [us] Point Angle [7] Pulse Width [us]
[oa | [200 | n |00 1

0.0 10 12 0.0 10
Analeg Inputs
v [ Schedule A

General

" Energy
v Schedule B
7 General
| Energy

" Miscellaneous
Alarms 0
] AsO1

Inputs ‘ Configure for DetCon2/20

Communication

| Information

& COM4 D MICS 5:2.20 (1.9.1 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2

With the auxiliary synchronization output, freely definable impulses depending on the angle of
the crankshaft can be generated. For the output, the user defines whether the angle will be
absolute or based on the global timing. The output can generate between 1 and 20 impulses and
only be assigned to one system at a time. One example of the application of the ASO output for a
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 70.

112

No. of Points

Select the number of impulses from the No. of Points list. Please note that the DetCon
detonation controller devices require a single impulse with 200 ps synchronous with the
first cylinder in the ignition sequence. You can get this setting via the button Configure for
DetConz/20.
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— Angle Reference
Select from the Angle Reference drop-down list whether the angle shall be based on the
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter
the trigger angle for each impulse and the length of the impulse in ps. This setting also
determines when ASO signals are generated. For this, also read the information box ASO
signals depending on the ignition release.

-  Mode

Select the mode for the ASO signal.
In the default setting Trailing Rising Edge (default), the signal is low-active.

Level
Fy
t1 t2 t3

High —r ~—r ---TH
! 1

F I F s
*) I
Low L +

°crank'5haft

In the setting Trailing Falling Edge (inverted), the signal is high-active.

Level
t1 t2 t3
High — — —
1y 4 +
Low - >

°crankshaft

*) active edge marks the configured engine rotation angle

® Maximum impulse duration
Please note that the duration of the impulse can be entered as max. 300 ps.
Input of higher values will not be accepted by the system.

NOTICE
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® ASO signals depending on the ignition release

The setting in the drop down list Angle Reference determines when ASO
signals are generated:

NOTICE — Actual Angles Depending on Global Timing
ASO pulses are only transmitted if ignition is active, indicated by the
green status display Firing Active in the window Runtime Data —
Overview.

— Absolute Timing
ASO pulses are generated independently of the ignition release as soon
as the synchronization of the pickups is accomplished.

8.11.12 Inputs/Outputs — Inputs

™! unnamed.mic5® (MIC5 5x2.20) - MICT = a X

File Device Settings Document Tools Help

AHFHS A R Ea

Configuration Page Input Settings
v Engine GPI Settings
| Parameters GPI1: | CAN reset (1s pulse), device reset (S s puise) -

1 Cylinder Names
| Ignition Qutputs
| Ignition Coils
| Pickups

v Timing
| Analog Inputs

v [ Schedule A
| General
" Energy
v ! Schedule B
7 General
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7 Miscellaneous
~ Inputs/Outputs
| Alarms
| ASO1
1 Inputs
¥ Miscellanecus
7 Communication

Information

@ COM4 ID MICS 5:2.20 (1.91 [0000ca01]) ADV.SERVICE Full Access Version: 2.42.2
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Various functions can be selected for the general purpose input GPI1:

Disabled
The input GPl1 will not be used.

CAN reset (1 s pulse), device reset (5 s pulse)

This feature allows (e.g. a master control) to trigger a CAN reset and/or a device reset
externally using a high impulse. A high impulse of 1 second leads to a reset of the CAN driver
and a high impulse of 5 seconds leads to a device reset.

Warning acknowledge (< 3 s high), error and alarm acknowledge (> 3 s high), device reset
(> 15 s high)

This feature allows (e.g. a master control) warnings, errors, and alarms to be confirmed
and/or device reset to be triggered externally using a high impulse. If the high impulse is
shorter than 3 seconds, all warnings will be confirmed. If the high impulse is longer than
3 seconds, all errors and alarms will be confirmed. If the high level lasts for m